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Preface
This documentation describes how to create the metadata for the data sources that your 
WebFOCUS projects will access. It is intended for database administrators, application 
developers, or other information technology professionals who will create the metadata 
used by WebFOCUS to access corporate data. 

How This Document Is Organized
This manual includes the following chapters:

Chapter/Appendix Description

1 Data Source Description 
Overview

Introduces data source descriptions and explains 
how to use them.

2 Creating Master Files Describes how to manage Master Files for reporting 
and data maintenance projects with the Master File 
Editor. This tool enables you to create a Master File 
and generate the data description language 
required to read the data in data sources.

3 Creating Synonyms Describes how to create a synonym for your data 
source description.

4 Defining Dimensions for 
OLAP Analysis

Describes how to use the Dimension Builder to 
create logical views based on enterprise data for 
multi-dimensional analysis.

5 Adding Data and Rebuilding 
FOCUS Data Sources

Describes utilities to create new FOCUS data sources 
and to refresh existing data sources after the 
structure has changed.

6 Creating Master and Access 
Files for Fusion Data Sources

Describes how to use the Filetool to create the 
Master and Access Files (metadata) you need to 
maintain local Fusion databases, and report from 
Fusion databases.
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Documentation Conventions
Documentation Conventions
The following conventions apply throughout this manual.

Convention Description

THIS TYPEFACE or

this typeface

Denotes syntax that you must enter exactly as shown.

this typeface Represents a placeholder (or variable) in syntax for a value that 
you or the system must supply.

underscore Indicates a default setting.

this typeface Represents a placeholder (or variable) in a text paragraph, a 
cross-reference, or an important term. It may also Indicate a 
button, menu item, or dialog box option you can click or select.

this typeface Highlights file names and commands (in a text paragraph) that 
must be lowercase.

Key + Key Indicates keys that must be pressed simultaneously.

{  } Indicates two choices from which you must choose one. You type 
one of these choices, not the braces. 

[  ] Indicates a group of optional parameters. None are required, but 
you may select one of them. Type only the information within the 
brackets, not the brackets.

| Separates two mutually exclusive choices in a syntax line. You 
type one of these choices, not the symbol.

... Indicates that you can enter a parameter multiple times. Type 
only the parameters, not the ellipsis points (…).

.

.

.

Indicates that there are (or could be) intervening or additional 
commands.
iv Information Builders



Preface
Related Publications
See the Information Builders Publications Catalog for the most up-to-date listing and prices 
of technical publications, plus ordering information. To obtain a catalog, contact the 
Publications Order Department at (800) 969-4636.

You can also visit our World Wide Web site, http://www.informationbuilders.com, to view a 
current listing of our publications and to place an order.

Customer Support
Do you have questions about Developer Studio?

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or 
(212) 736-6130. Customer Support Consultants are available Monday through Friday 
between 8:00 a.m. and 8:00 p.m. EST to address all your Developer Studio questions. 
Information Builders consultants can also give you general guidance regarding product 
capabilities and documentation. Please be ready to provide your six-digit site code number 
(xxxx.xx) when you call.

You can also access support services electronically, 24 hours a day, with InfoResponse 
Online. InfoResponse Online is accessible through our World Wide Web site, 
www.informationbuilders.com. It connects you to the tracking system and known-problem 
database at the Information Builders support center. Registered users can open, update, 
and view the status of cases in the tracking system, and read descriptions of reported 
software issues. New users can register immediately for this service. The technical support 
section of www.informationbuilders.com also provides usage techniques, diagnostic tips, 
and answers to frequently asked questions.

To learn about the full range of available support services, ask your Information Builders 
representative about InfoResponse, or call (800) 969-INFO.

Information You Should Have
To help our consultants answer your questions most effectively, be ready to provide the 
following information when you call: 

• Your six-digit site code number (xxxx.xx).
Describing Data With Graphical Tools v
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User Feedback
• Your Developer Studio configuration:

• The front end you are using, including vendor and release.

• The communications protocol (for example, TCP/IP or HLLAPI), including vendor 
and release.

• The software release.

• The server you are accessing, including release (for example, 4.3.5).

• The stored procedure (preferably with line numbers) or FOCUS commands being used 
in server access.

• The name of the Master File and Access File.

• The exact nature of the problem: 

• Are the results or the format incorrect; are the text or calculations missing or 
misplaced? 

• The error message and return code, if applicable.

• Is this related to any other problem?

• Has the procedure or query ever worked in its present form? Has it been changed 
recently? How often does the problem occur?

• What release of the operating system are you using? Has it, Developer Studio, your 
security system, communications protocol, or front-end software changed?

• Is this problem reproducible? If so, how?

• Have you tried to reproduce your problem in the simplest form possible? For example, 
if you are having problems joining two databases, have you tried executing a query 
containing just the code to access the database?

• Do you have a trace file?

• How is the problem affecting your business? Is it halting development or production? 
Do you just have questions about functionality or documentation?

User Feedback
In an effort to produce effective documentation, the Documentation Services staff at 
Information Builders welcomes any opinion you can offer regarding this manual. Please use 
the Reader Comments form at the end of this manual to relay suggestions for improving 
the publication or to alert us to corrections. You can also use the Document Enhancement 
Request Form on our Web site, http://www.informationbuilders.com.

Thank you, in advance, for your comments.
vi Information Builders
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Preface
Information Builders Consulting and Training
Interested in training? Information Builders Education Department offers a wide variety of 
training courses for this and other Information Builders products.

For information on course descriptions, locations, and dates or to register for classes, visit 
our World Wide Web site (http://www.informationbuilders.com) or call (800) 969-INFO to 
speak to an Education Representative.
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CHAPTER 1

Data Source Description Overview

Topics:

• A Note About Data Source 
Terminology

• What Is a Data Source Description?

• How a Project Uses a Data Source 
Description

• What Does a Master File Describe?

• Creating a Data Source Description

• What Is in a Master File?

Information Builders products provide a flexible data 
description language, which you can use with many types 
of data sources, including:     

• Relational, such as DB2, Oracle, Sybase, and Teradata.

• Hierarchical, such as IMS and FOCUS.

• Network, such as CA-IDMS.

• Indexed, such as ISAM and VSAM.

• Sequential, both fixed-format and free-format.

• Multi-dimensional, such as Fusion.

You can also use the data description language and related 
facilities to:

• Join different types of data sources into a temporary 
structure from which your request can read or write.

• Define a subset of fields or columns to be available to 
users.

• Logically rearrange a data source to access the data in a 
different order.
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A Note About Data Source Terminology
A Note About Data Source Terminology
Different types of data sources make use of similar concepts, but refer to them differently. 
For example, the smallest meaningful element of data is called a field by many hierarchical 
database management systems and indexed data access methods, but called a column by 
relational database management systems.       

There are other cases in which a common concept is identified by a number of different 
terms. For simplicity, we have standardized on a single set of terms. For example, we usually 
refer to the smallest meaningful element of data as a field, regardless of the type of data 
source. However, when required for clarity, we use the term specific to a given data source. 
Each time we introduce a new standard term, we define it and compare it to equivalent 
terms used with different types of data sources.

What Is a Data Source Description?
When your project accesses a data source, it needs to know how to interpret the data that it 
finds. Your project needs to know about:         

• The overall structure of the data. For example, is the data relational, hierarchical, or 
sequential? Depending upon the structure, how is it arranged or indexed?

• The specific data elements. For example, what fields are stored in the data source, and 
what is the data type of each field—character, date, integer, or some other type?

To obtain the necessary information, your project reads a data source description. The 
primary component of a data source description is called a Master File. A Master File 
describes the structure of a data source and its fields. For example, it includes information 
such as field names and data types.

For some types of data sources, an Access File supplements a Master File. An Access File 
includes additional information that completes the description of the data source. For 
example, it includes the full data source name and location. You need one Master File—and, 
for some types of data sources, one Access File—to describe a data source.
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How a Project Uses a Data Source Description
Master Files and Access Files are stored separately, apart from the associated data source. 
Your project uses a data source’s Master File (and if required, the corresponding Access File) 
to interpret the data source in the following way:     

1. Identifies, locates, and reads the Master File for the data source named in a request.

If the Master File is already in memory, your project uses the memory image and then 
proceeds to Step 4. If the Master File is not in memory, the project locates the Master 
File on a storage device and loads it into memory, replacing any existing Master File in 
memory. If your Master File references other data sources as cross-referenced 
segments, or if a JOIN command is in effect for this file, the cross-referenced Master 
Files are also read into memory.

2. Reads the security rules if Information Builders data source security (DBA) has been 
specified for the data source and ensures that user access is based on any DBA security 
specified.

3. Locates and reads the Access File for the data source named in the request, if that type 
of data source requires an Access File.

4. Locates and reads the data source(s).

The data source contents are interpreted based on the information in the Master File and, if 
applicable, the Access File.

What Does a Master File Describe?
A Master File enables you to:    

• Identify the name and type of a data source.

• Identify and relate groups of fields.

• Describe individual fields.

Identifying a Data Source
In order to interpret data, your project needs to know the name you are using to identify 
the data source and what type of data source it is. For example, is it a DB2 data source, an 
Oracle data source, or a FOCUS data source?      

For more information about identifying a data source, see Chapter 2, Creating Master Files 
and Chapter 6, Creating Master and Access Files for Fusion Data Sources.
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Identifying and Relating a Group of Fields
A Master File identifies and relates groups of fields that have a one-to-one correspondence 
with each other—in Master File terms, a segment; in relational terms, a table.      

You can join data sources of the same type (using a Master File or a JOIN command) and 
data sources of different types (using a JOIN command). For example, you can join two DB2 
data sources to a FOCUS data source, and then to a VSAM data source.

For more information about defining and relating groups of fields, see Chapter 2, Creating 
Master Files and Chapter 6, Creating Master and Access Files for Fusion Data Sources.

Describing a Field
Every field has several characteristics that you must describe in a Master File, such as type of 
data and length or scale. A Master File can also indicate optional field characteristics. For 
example, a Master File can specify if the field can have a null value, and can provide 
descriptive information for the field.      

A Master File usually describes all of the fields in a data source. In some cases, however, you 
can create a logical view of the data source in which only a subset of the fields is available, 
and then describe only those fields in your Master File.

For more information about describing individual fields, see Chapter 2, Creating Master Files 
and Chapter 6, Creating Master and Access Files for Fusion Data Sources.

Creating a Data Source Description

• Has an existing description—such as a native schema or catalog, or a COBOL File 
Description—you can use a tool to automatically generate the Master File and Access 
File from the existing description. For example, if you want to use WebFOCUS to read a 
DB2 data source, you can use the Synonym Wizard to generate a Master File and Access 
File from the DB2 catalog.

For more information about generating a Master File and Access File, see Chapter 3, 
Creating Synonyms.

You can create a Master File and Access File for a data source in several ways. If the data 
source:      
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• Does not have an existing description, you can create a Master File by coding it using 
Information Builders’ data source description language, or by specifying its attributes 
using the Master File Editor. 

For more information about creating a Master File with graphical tools, see Chapter 2, 
Creating Master Files and Chapter 6, Creating Master and Access Files for Fusion Data 
Sources.

For details about coding Master Files, see Describing Data With WebFOCUS Language.

Creating a Master File and Access File Using an Editor
You can create a Master File and an Access File by:      

• Coding them using a text editor. You can do this in all Information Builders products. 
For information on Master File syntax, see Chapter 2, Creating Master Files and Chapter 
6, Creating Master and Access Files for Fusion Data Sources. For information about Access 
File syntax, see your data adapter documentation.

After editing a Master File, issue the CHECK FILE command to validate the new Master 
File and to refresh your session’s image of it.

• Specifying their attributes using the Master File Editor. The Master File Editor tool is 
available in WebFOCUS (Windows version) products.

What Is in a Master File?
A Master File describes a data source using a series of declarations:    

• A data source declaration.

• A segment declaration for each segment within the data source.

• A field declaration for each field within a segment.

The specifications for an Access File are similar, although the details vary by type of data 
source. The appropriate documentation for your data adapter indicates whether you 
require an Access File and, if so, what the Access File attributes are.
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Syntax How to Specify a Declaration

Each declaration specifies a series of attributes in the form   

attribute = value, attribute = value, ... ,$

where:

attribute

Is a Master File keyword that identifies a file, segment, or field property. You can specify 
any Master File attribute by its full name, its alias, or its shortest unique truncation. For 
example, you can use the full attribute FILENAME or the shorter form FILE.

value

Is the value of the attribute.

A comma follows each attribute assignment, and each field declaration ends with a dollar 
sign ($). Commas and dollar signs are optional at the end of data source and segment 
declarations.

Each declaration should begin on a new line. You can extend a declaration across as many 
lines as you wish. For a given declaration you can put each attribute assignment on a 
separate line, combine several attributes on each line, or include the entire declaration on a 
single line. Each line can be a maximum of 80 characters long.
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CHAPTER 2

Creating Master Files

Topics:

• Master File Editor

• Sample Master Files

• Creating a Master File Shell

• Identifying the Type of Data Source 
You Are Describing

• Assigning Century Values in a 
Master File

• Associating a National Language 
Code Page With a Master File

• Describing the Segments in a 
Master File

• Describing the Fields in a Segment

• OLAP-enabling a Master File

• Adding Virtual Fields to a Segment

• Adding Group Fields to a Segment

• Creating a Cross-Reference

• Setting Up Security for a Master File

• Viewing the Master File Layout

• Previewing and Printing a Master 
File

You can manage Master Files for reporting and data 
maintenance projects with the Master File Editor. This tool 
enables you to create a Master File and generate the data 
description language required to read the data in data 
sources. For related information, see Chapter 1, Data Source 
Description Overview. Maintain users should see the 
WebFOCUS Maintain documentation for details about the 
data description language.      

Note: The tools for managing a data maintenance project 
are available only in the Developer’s Studio version of this 
product. If you have this version, note that some features of 
the Master File Editor are useful in reporting projects, but 
are not relevant in data maintenance projects and are 
clearly noted in the text.
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Master File Editor
The Master File Editor is a multi-pane window with an Explorer tree structure in the left 
pane and tabs in the right pane that correspond to the item selected in the tree.      

Left pane (Master File) 

Displays a hierarchical view of the Master File. The hierarchical view includes the 
directory path for the Master File and the root segment, followed by either fields, or 
other segments with fields.

As you add segments and fields to the Master File, the editor builds the hierarchical 
structure for you. This structure displays a new segment under its parent segment, and 
fields under the segment to which they belong.

Right pane (Properties)

Displays information about the file, a segment, or a field (whichever is selected in the 
left pane). For each file element, the Properties pane adjusts to gather the required 
(and optional) information; tabs are used to group this information. 

Toolbar

Gives you access to the Master File Editor functions you use most often to describe 
segments, unique segments, cross-referenced segments, fields, temporary fields 
(virtual), group fields, and to show the layout of the Master File.

Menu bar

Gives you access to every function of the Master File Editor.
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Sample Master Files
This product includes several sample Master Files (.MAS) and corresponding data source 
(.FOC). You can use these samples as a learning tool when using the Master File Editor.  

You can also use these samples to practice creating projects or building procedures and 
components.

There are several types of samples:

• Reporting and data maintenance. Designed for use in the reporting and Maintain 
environments. There are 24 sample Master Files, some of which demonstrate a specific 
feature.

• Standard Sample Master Files

These can be used in either the reporting or Maintain environments. Several of 
these are primarily for reporting (finance, ledger, and region).

These sample data sources are located in the install_drive/ibi/apps/ibisamp 
directory path.

• Fannames Sample Master Files

The Fannames sample Master Files are primarily for data maintenance projects and 
were designed for use in the Maintain environment.

These samples are located in the in the install_drive/ibi/apps/ibisamp directory 
path.

These samples are only available in the Developer’s Studio version of this product.

Maintain users should see the WebFOCUS Maintain documentation for details on 
the Fannames sample Master Files.

• OLAP. Designed with Online Analytical Processing (OLAP) capabilities. You can use 
these sample Master Files to see how a Master File is OLAP-enabled and to create 
report procedures from which you can invoke the OLAP Control Panel, a control panel 
that enables you to manipulate OLAP-enabled data. For more information on OLAP, see 
Creating Reports With Graphical Tools. These samples are located in the in the 
install_drive/ibi/apps/ibisamp directory path. 

• Managed Reporting. Designed for use as domains (Gotham Grinds Franchise Sales 
and Gotham Grinds Purchasing and Inventory Management) in the Managed 
Reporting environment. These include sample Standard Reports and Reporting 
Objects. These samples are located in the install_drive/ibi/apps/ibisamp directory path.
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Note: These sample Master Files can be used as Gotham Grinds Franchise Sales and 
Gotham Grinds Purchasing and Inventory Management projects in the reporting and 
Maintain environments. Right-click the Managed Reporting folder in the WebFOCUS 
Environment in the WebFOCUS Explorer. Click each domain in the Managed Reporting 
folder and then return to the developer’s environment.

Creating a Master File Shell

You begin creating a Master File shell by assigning a file name. For Master Files accessing 
relational data sources, the file name can consist of up to 64 alphanumeric characters and 
must contain at least one letter. You should make the name representative of the data 
source contents. It can have the same name as the data source it is describing if the name 
complies with naming conventions. After assigning the file name, you are ready to build 
your data description.

Note: For Master Files accessing FOCUS data sources, the file name can consist of up to 8 
alphanumeric characters and must contain at least one letter.

The Master File shell, when opened in the Master File Editor, displays the directory path, 
root segment, and root segment key field in the left panel. In this panel you can add 
segments and then fields to those segments. The right panel displays the file level 
properties: General, DBA, and Codepage tabs. Note that when you select a segment or field 
level, properties change accordingly.

After you create the shell file you need to:

• Set the file level properties by identifying the type of data source you are describing 
(see Identifying the Type of Data Source You Are Describing on page 2-6), setting 
cross-century values (see Assigning Century Values in a Master File on page 2-8), and 
including a description for the Master File.

• Develop the Master File segments and fields.

• Apply appropriate security restrictions to the Master File. See Setting Up Security for a 
Master File on page 2-38.

• Associate a national language code page if the Master File will be used in a project 
internationally. See Associating a National Language Code Page With a Master File on 
page 2-9.

You can create a Master File shell for a FOCUS data source, for supported relational data 
sources, and for data sources that reside on a WebFOCUS Reporting Server.      
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Master Files often work in conjunction with an Access File. For FOCUS data sources, you do 
not need an Access File. However, to locate data in a relational data source you do need an 
Access File, which you cannot create with this editor. Instead you must code the Access File 
using your text editor. If a related Access File is required, you must code it manually and 
assign the same name as its corresponding Master File.

As a simpler alternative, you can generate synonyms for both the Master and Access Files 
using the Create Synonym Wizard, which is accessible only when working from a reporting 
application environment. For details, see Chapter 3, Creating Synonyms. 

Procedure How to Create a Master File Shell (Reporting Environment)

1. From an open project, right-click the Master Files folder and select New or choose New 
from the File menu.      

The New Master File dialog box opens. Note that the Suffix drop-down box defaults to 
the FOCUS (FOC) suffix.

2. Type a name for the Master File in the text entry field.

3. Click OK., The shell file opens in the Master File Editor. Your next step is to choose a data 
source type. See Identifying the Type of Data Source You Are Describing on page 2-6 and 
How to Choose a Data Source Type on page 2-6.

Procedure How to Create a Master File Shell (Maintain Environment)

1. Click   (New database description) on the Application toolbar.      

or

Right-click the Databases folder and choose New database description from the shortcut 
menu.

2. Type a new name for your Master File and press Enter. The name must start with a letter 
and cannot contain special characters. Otherwise, simply press Enter to accept the 
default name.

3. Select Save from the File menu., You have created the Master File shell file that will 
contain the data description.

4. Open the shell file in the Master File Editor. Right-click the Master File shell in the 
Databases folder. Select Edit description from the shortcut menu., The shell file opens in 
the Master File Editor. Your next step is to choose a data source type. See Identifying the 
Type of Data Source You Are Describing on page 2-6 and How to Choose a Data Source 
Type on page 2-6.
Describing Data with Graphical Tools 2-5



Identifying the Type of Data Source You Are Describing
Identifying the Type of Data Source You Are Describing

Procedure How to Choose a Data Source Type

1. In the General tab, select a data source type from the drop-down list to identify the 
type of data source you are using.  

Note: For details on creating descriptions for Fusion data sources, see Chapter 6, 
Creating Master and Access Files for Fusion Data Sources.

2. Select Save from the File menu.

Once you specify the data source type, you can assign century options and begin to 
develop the Master File segments and fields. See Master File Tab: General (Segment Level) on 
page 2-13 for additional information.

Note: When the Master File is complete, you can apply security restrictions (see Setting Up 
Security for a Master File on page 2-38) and associate a code page for international support 
(see Associating a National Language Code Page With a Master File on page 2-9).

Reference Supported Data Source Types and Suffixes

After naming your data source, you must indicate the type of data source you wish to 
describe by choosing an abbreviation for the data source type—for example, FOC 
represents a FOCUS data source and SQLORA represents an Oracle table. For details, see 
Supported Data Source Types and Suffixes on page 2-6.  

Data Source Type Suffix

Adabas ADBSIN

Comma Delimited (not supported for Maintain) COM

dBase DBASE

EDA EDA

Fixed Format FIX

FOCUS FOC

FUSION FUSION

Hyperion ESSBase (not supported for Maintain) ESSBASE
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Reference Master File Tab: General (File Level)

IBM DB2 SQL

Also supports DB2, SQL400, SQLDS, 
SQLDBM

Informix SQLINF

Microsoft Access (not supported for Maintain) SQLMAC

Microsoft SQL Server SQLMSS

MS SQL Server OLAP Services (not supported for 
Maintain)

MSOLAP

ODBC SQLODBC

Oracle SQLORA

Sybase SQLSYB

Tab Delimited (TABT)

Teradata (SQLDBC)

Data Source Type Suffix
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When you select a data source in the left (Master File) frame, the General tab has the 
following fields/options:        

File Type

Choose the type of data source you will be describing. For details, see Identifying the 
Type of Data Source You Are Describing on page 2-6.

Default century options 

Together these options define a range of 100 years and control the century value for all 
date fields in the data source.

Choose a century value to represent 1900 or 2000.

Choose a base year that represents the lowest year to which the century option applies.

The defaults are 19 and 00, respectively.

For details, see Assigning Century Values in a Master File on page 2-8. 

Description

Type a descriptive name for the Master File. This name appears as the REMARK field 
when you view the Master File as text.

Assigning Century Values in a Master File

The century value and base year together define a range of 100 years:

• Century value specifies a two-digit century number.

• Base year indicates the lowest year to which this century applies.

For example, if the century value is 19 and the base year is 80, year values from 80 through 
99 are interpreted as 1980 through 1999, and year values from 00 through 79 are 
interpreted as 2000 through 2079.

If you are satisfied with the century value and the base year default values (19 and 00, 
respectively), you can omit one or both of these options from the Master File.

You can set century default options for the Master File at the file or field levels. A century 
value setting at the field level will override a century value setting at the file level. See 
Master File Tab: General (File Level) on page 2-7 and Master File Tab: General (Field Level) on 
page 2-21.

Note: You can also set century values for all Master Files used by a project. For details, see 
SET DEFCENT and SET YRTHRESH in your documentation on setting environment 
parameters.

The Master File Editor enables you to assign century options—the two-digit century value 
and the two-digit base years—to control the century value in a Master File.  
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Procedure How to Set Century Values for a Master File at the File Level

1. Select the file name in the Master File hierarchy (left frame).  

2. In the General tab (File level), choose a century value to represent 1900 or 2000. The 
default is 19.

3. Choose a base year value to represent the lowest year to which the century value 
applies. The default is 00.

Procedure How to Set Century Values for a Master File at the Field Level

1. Select a field in the Master File hierarchy (left pane).  

2. In the General tab (Field level), select Date format.

3. Choose a century value to represent 1900 or 2000. The default is 19.

4. Choose a base year value to represent the lowest year to which the century value 
applies. The default is 00.

Associating a National Language Code Page With a Master File

NLS ensures that data source utilities and error messages are presented to the user in the 
appropriate native language for French, German, Japanese, and Spanish. All other language 
options display in English.

NLS eliminates the requirement for locale-specific coding in your projects. Through a 
one-time configuration by the administrator, NLS enables you to store code pages for 
language locales, retrieving one code page at a time. When necessary, NLS allows you to 
conveniently add new language locales without having to perform a full reconfiguration. 
For information on NLS configuration, see National Language Support for International 
Computing.

If NLS is configured correctly on your PC, you can associate a code page to a Master File. 
Every time you use that Master File to create a report, the code page you selected converts 
character sets in the Master File to the appropriate character sets found in the selected 
code page. The resulting report displays with the character sets from your chosen code 
page.

If your reporting or data maintenance projects are used internationally, you can set up any 
Master File in your project to provide comprehensive National Language Support (NLS); the 
display of foreign language characters in data. NLS allows you to store, process, and retrieve 
native language data using code pages to map characters between different character sets. 
It allows data to be sorted and presented in culturally appropriate time, date, calendar, 
monetary, and numeric formats that are essential for everyday use.   
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Note: The Master File Editor does not support Master Files that contain OEM (DOS) national 
characters. In order to prevent corruption, use the Developer Studio text editor (TED) to 
edit these types of Master Files.

Procedure How to Associate a Code Page With a Master File

Note: In order for the code page you select to work, NLS must be configured first. For 
information on NLS configuration, see National Language Support for International 
Computing.   

1. Select the location path in the Master File hierarchy (left pane).

2. Select the Codepage tab.

3. Select a code page from the list to associate with the Master File.

See Master File Tab: General (File Level) on page 2-7 for additional information.

Reference Master File Tab: Code Page (File Level)
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Describing the Segments in a Master File

Master Files have three types of segments: 

• Root segment. The first segment in a FOCUS data source. It is the only segment in a 
Master File referred to by a special name. All instances in descendant segments start 
from an instance in the root segment.

In the Master File pane, you can find the root segment directly below the path. This 
segment is identified by a lock symbol.

Note: In a relational data source, a table is represented as a segment.

• Parent segment. A segment that is a part of a higher segment (referred to as the 
“parent” segment) and can have descendants of its own. For each parent segment 
instance, there can be one or more related records in a descendant or “child” segment.

• Unique segment. A segment that has a one-to-one relationship with its parent 
segment and cannot have descendent segments. A unique segment is a logical 
extension of its parent segment. When data values in a unique segment are retrieved, 
they are treated as if they were part of the parent segment.

The segment type displays in the General tab (Segment Level).

When you add a segment to a Master File, you:

• Specify a name for the segment.

• Indicate the type of segment you are adding: parent or unique.

• Specify sorting criteria for a parent segment (sorting criteria are not required for unique 
segments).

• Indicate whether you wish to encrypt the segment to protect it against unauthorized 
examination.

• Specify a location to store that segment.

 For details, see How to Describe a Segment on page 2-12 and Master File Tab: General 
(Segment Level) on page 2-13.

A segment is a group of fields that are related to one another. Each segment has a unique 
name and each can have its own key field(s). Master Files have three types of segments:      
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Procedure How to Describe a Segment

1. Click the parent segment. In the case of a new Master File, click the root segment, then 
perform one of the following actions:  

• Right-click and select New, then choose Parent from the cascading menu.

• Click the Segment button on the editor toolbar.

• Select Parent from the Insert menu.

In the left pane, the segment icon is added beneath the last field in the parent or root 
segment. The General tab opens in the right pane. 

2. Type a name for the segment, using uppercase characters, in the Segment Name box.

3. Make sure a DBA password has already been assigned. For details, see How to Set Up 
Security for the Database Administrator on page 2-39 and Master File Tab: General 
(Segment Level) on page 2-13. Encryption will not occur properly if the DBA password 
has not been set prior to the encryption of a segment.

4. Click the Encrypt box if you want to encrypt the segment.

5. Select a segment type: either Parent segment or Unique segment., If you select Unique, 
you do not specify sorting criteria.

6. Select sorting criteria for the Parent segment.

a. Specify the number of fields you intend to use as key fields.

b. Select one of the following:

Sort records in ascending order.

Sort records in descending order.

Do not sort records.

7. Type a location where you want to store this segment.

8. Once you have defined the segment, you can define the fields that will populate it. See 
Describing the Fields in a Segment on page 2-18.

Procedure How to Delete a Segment

Right-click the segment, then select Delete.  

Note: You cannot delete a root segment.
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Reference Master File Tab: General (Segment Level)

When a segment is selected in the left (Master File) frame, the General tab has the following 
fields/options:  

Segment Name

Assign a name of up to 8 characters to the segment, using uppercase characters. All 
characters and digits are permitted, except embedded blanks and special characters. 

Encrypt 

Check this box to scramble field values in the current segment in order to protect it 
from unauthorized examination.

Note: You must assign a DBA password to the file before setting the Encrypt option on. 
For details, see How to Encrypt a Segment on page 2-42. You must then turn the Encrypt 
option on before adding any records. If you add a record to a segment before setting 
the Encrypt option on, that value will not be encrypted.

Once a segment is encrypted, you can remove encryption only if you remove the 
segment and recreate it without turning on the Encrypt option.

Tip:  Because there is a loss of processing efficiency when data is encrypted, encryption 
should be used selectively.
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Segment Type 

Identify the segment as:

• Root, the top segment in the data source hierarchy. (For a relational data source 
this is the only segment.)

• Parent, a segment that can have descendant segments with one or more related 
records.

• Unique, a segment with a one-to-one relationship to its parent, and no 
descendant segments.

You can change the type of a parent or unique segment (if necessary).

Sorting 

Records are sorted in a data source by key fields. A key uniquely identifies each 
segment instance. For example, no two employees can have the same employee ID 
number, so you can use that field as the key. A segment instance can have more than 
one field that makes up the key; that is, two or more field values may be used to 
distinguish records. Key fields appear before all other fields in a segment and are 
indicated by a key symbol.

Sorting criteria are required for a parent segment, but not for a unique segment. For a 
parent segment sorting is based on the key. If you specify more than one key field in 
the key, records are sorted by the first key field, then the second, and so on.

• First, enter the number of key fields that you want to use for sorting.

• Then indicate whether you want to sort records in ascending or descending order, 
or choose Do not sort records. Ascending is the default.

Storing a Segment in a Different Location

Note: This feature only applies to Master Files for FOCUS data sources.  

You store segments in a separate file for two reasons:

• To apply security. You can store data in separate physical files to show only the 
segments needed for a report. Unreferenced segments can be stored in a separate file 
and archived, but must be restored before they are accessed in a FOCUS request. 
Alternately, they can be kept on another disk, where separate security can be arranged. 
In some situations, the separation of the segments into different files allows different 
disk drives to be used.

By default, all of the segments in a FOCUS data source are stored in one physical file. 
Optionally, you can designate one or more segments to be stored in a separate physical file 
called the Location file.
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Note: Divided data sources require more careful file maintenance. You have to be 
especially careful about procedures that are performed separately on these files, such 
as backups. For example, if you perform backups on Tuesday and Thursday for two 
related files, and you restore the FOCUS structure using the Tuesday backup for one 
half and the Thursday backup for the other, FOCUS has no way of detecting this 
discrepancy.

• To increase the size of a FOCUS data source beyond the normal maximum of 1 
gigabyte. You can split the data source into several physical files, each one subject to 
the 1 gigabyte page maximum.

Procedure How to Store a Segment in a Different Location

Tip: Before completing this procedure we suggest that you read Usage Notes for Storing 
Segments in Different Locations on page 2-15.

1. In the Master File hierarchy (left pane), select the segment that you want to store in a 
separate location.  

2. In the General tab, type the name of the location file in the Location text box. This name 
can be up to 8 characters long.

Repeat steps 1 and 2 to store additional segments.

Reference Usage Notes for Storing Segments in Different Locations

• The name of the location file can be either the file name of a FOCUS data source, or a 
name assigned by the USE command.  

• The location must be changed if the location file name or the name assigned by a USE 
command is changed.

• You can name multiple location files in a Master File. You can also store different 
segments in the same location file.

• Descendant segments will be stored in the same location file as a parent segment 
unless different location files are included in their segment declarations.

• For reporting, the location file does not need to be available to FOCUS at all times. 
FOCUS can still access the data in other segments. However, to include data from the 
location file in the report, both the host data file and the location file must be available. 
FOCUS can only access the data in the location file through the information stored in 
the host file. For data maintenance, location files must be available to FOCUS.

• The number of different location segments and text location files you can specify is 
limited to a maximum of 64 entries.
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Describing Repeating Fields in a Segment

For instance, consider a library file that contains the information for two copies of The Sun 
Also Rises, one hardcover ($17.95) and one paperback ($5.25). There are two values for 
binding and price, both corresponding to the same book. In the Master File, the 
information that occurs only once—book information: the publisher’s number, author, and 
title—is placed in one segment and the information that occurs several times in relation to 
this information—binding and price—is placed in a descendant segment. Similarly, 
information that occurs several times in relation to the descendant segment, such as an 
individual serial number for each copy of the book, is placed in a segment that is a 
descendant of the first descendant segment.

Since the root segment is the highest-level segment in a Master File, all segments below it 
are considered parent segments. Thus, you are able to describe multiply occurring records 
for any segment below the root segment.

There are two basic types of multiply occurring records: parallel sets and nested sets. 
Parallel sets of repeating fields are those that have nothing to do with one another (that is, 
they have no parent-child or logical relationship). Nested sets of repeating fields are those 
that, in some way, depend on one another.

Maintain users should see the WebFOCUS Maintain documentation for more information 
and detailed examples on describing repeating fields.

Procedure How to Describe Repeating Fields in a Segment

1. In a free-format (comma-delimited) or fixed-format Master File, select the segment that 
contains the repeating fields in the Master File hierarchy (left pane).    

The General and Occurs tabs for that segment display. Note that if you select the root 
segment, the Occurs tab does not appear because this segment is the highest-level 
segment in a Master File.

2. Select the Occurs tab and describe the repeating fields by choosing one of the 
following options:

• Value. Type a value from 1-4095. Optionally, you can specify the position by 
selecting the field in which the records reside from the drop-down list. This field list 
is derived from the parent segment.

• Fieldname. Select the field that contains the multiply occurring fields from the 
drop-down list. This field list is derived from the parent segment.

In a Master File, you can describe multiply occurring records for free-format 
(comma-delimited) and fixed-format sequential data sources. This is accomplished by 
creating a descending segment and defining the occurring fields in the descendent 
segment of the parent segment. You can have one or many descending segments 
depending on the structure of the data.   
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• Variable. Indicates that the number of occurrences varies from record to record.

For information that will help you choose an option, see Master File Tab: OCCURS 
(Segment Level) on page 2-17.

Reference Master File Tab: OCCURS (Segment Level)

When a segment is selected in the left (Master File) frame, the Occurs tab has the following 
fields/options:  

Parent Segment

The segment that is a part of a higher segment (referred to as the “parent” segment) 
and can have descendants of its own.

Occurs 

Describe the repeating field by selecting one of the following options:

• Value (1-4095). Type a value from 1-4095. Optionally, you can specify the position 
where a field occurs in a record, if it is not at the end, by selecting the field from the 
drop-down list. See Position.

• Fieldname. Names an integer field in the parent segment that is a counter 
containing the number of occurrences of the descendant segment. Select the field 
that contains the multiply occurring fields from the drop-down list. This field list is 
derived from the parent segment.
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• Variable. Indicates that the number of occurrences varies from record to record. 
The number of occurrences is computed from the record length (that is, if the field 
lengths for the segment add up to 40, and 120 characters are read in, it means 
there are three occurrences).

Position 

When the Value (1-4095) field is selected, this field is enabled. It is derived from the 
parent segment and is an optional function. It is used to describe a structure in which 
multiply occurring fields with an established number of occurrences are located in the 
middle of the record. You describe the data source as a hierarchical structure, made up 
of a parent segment and at least one descendent segment that contains the multiply 
occurring fields. The parent segment is made up of whatever singly occurring fields are 
in the record, as well as an alphanumeric field that appears where the multiply 
occurring fields appear in the record. The alphanumeric field is a dummy field that is 
the exact length of the combined multiply occurring fields. For example, if you have 
four occurrences of an eight-character field, the length of the dummy field in the 
parent segment will be 32 characters.

Note: When different types of records are combined in one data source, each record 
type can contain only one segment defined as variable. It may have descendants (if it 
contains a nested group), but it may not be followed by any other segment with the 
same parent—that is, there can be no other segments to its right in the hierarchical 
data structure. This restriction is necessary to ensure that data in the record is 
interpreted unambiguously by FOCUS.

Describing the Fields in a Segment

• General. You supply the field characteristics: the field name, field alias, field format 
(alphanumeric, numeric, or date), if the field is indexed, if the field allows missing data, 
and if the field is a parent or child in a hierarchy that can be used for financial reporting. 

• Display. You supply supplementary field information for reporting, such as title, help 
message, and description. 

• Accept. You supply validation criteria (acceptable values) for a field. Validation criteria 
restrict the values a user can enter for the field. 

• OLAP. You supply a dimension name to be associated with fields. This process 
OLAP-enables the Master File. (This feature is not used in data maintenance projects.)

You must supply at least a field name and a field format. See How to Describe a Field in a 
Segment on page 2-19 for details on entering required and optional information.

When you add a field to a segment, the Master File Editor places a field icon below the 
segment in the Master File tree (left pane) and displays four properties tabs in the right 
pane, in which you supply the information that defines the field. The tabs are:          
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Procedure How to Describe a Field in a Segment

1. In the Master File hierarchy (left pane), select the segment in which you want to add a 
field, then perform one of the following actions:                

• Right-click and select New from the shortcut menu, then choose Field from the 
cascading menu.

• Click the New Field button on the editor’s toolbar.

• Select Field from the Insert menu.

You see the General, Display, Accept, and OLAP tabs in the right pane.

2. In the General tab:

a. Type a name for the field, using uppercase characters, in the Field Name input box 
(required).

b. Type an alias for the field in the Field Alias input box (optional). (Note that aliases 
are not used by the Maintain language; however, they may be used in report 
requests.)

c. If you are defining a hierarchy for financial reporting, describe the parent/child 
relationship, and, optionally, a descriptive caption to use in place of hierarchy field 
values, in the Field Property and Field Reference boxes. 

d. Click the Index box if you want the field to be indexed. 

e. Select a format or data type, then specify the length, the decimal places (if 
applicable) and any display options for the field. The data type (numeric, 
alphanumeric, date), field length and, for some numeric formats, decimal places are 
required parameters; display options are not. Maintain users should see the 
WebFOCUS Maintain documentation for more information.

f. Click the Allow Missing Data box if you want to enter a missing value for a field. 

For details about all of these entries, see Master File Tab: General (Field Level) on 
page 2-21.

3. Click the Display tab if you wish to include a column title, help message, or description 
for the field. To include any of these characteristics, type the text in the appropriate 
input box. (Note that these options apply only to reporting.) For details, see  Master File 
Tab: Display (Field Level) on page 2-24. 

4. Click the Accept tab to specify acceptable values. These serve as validation criteria to 
limit the values that a user can enter for the field. If you specify a list of values, you can 
also use them to populate radio buttons, combo boxes, and list boxes. The default 
value is None, which indicates no validation criteria. For details, see Master File Tab: 
Accept (Field Level) on page 2-25. 
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Select List of values to specify a list of acceptable field values:

a. Type a value in the input box and press Enter., The value is added to the list box.

b. Continue to type values and add them to the list box.

Select Range of values to specify a range of acceptable field values:

a. Type the minimum range value in the From input box.

b. Type the maximum range value in the To input box.

Select Find to supply file and field names to instruct FOCUS where to search for a data 
source and for a list of acceptable values. You supply the field name of the data field for 
which the validation criteria are being assigned, the file name of the target FOCUS data 
source where the field can be found, and the field name of the target data field that 
contains the validation criteria.

Note: Find is only available for FOCUS data sources and does not apply to 
OLAP-enabled Master Files. Note also that, in the Maintain environment, Find is not 
supported when developing a Master File.

Once you have supplied information for the required parameters and any optional 
parameters, the field definition is complete. You can now add other fields to the current 
segment, add fields to another segment, or create a new segment.

5. Click the OLAP tab to create a dimension and associate it to the fields you selected. 
After you create the dimension you can associate other fields to it. For details, see 
OLAP-enabling a Master File on page 2-26., This step does not apply in data 
maintenance projects.

Procedure How to Delete a Field From a Segment

Right-click the field, then select Delete.  
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Reference Master File Tab: General (Field Level)

When a field is selected in the left (Master File) frame, the General tab has the following 
fields/options:              

Field Name 

Enter a unique name (1-66 characters) in uppercase characters. The first character must 
be a letter. Do not use embedded blanks or special characters if you wish to include the 
field in a calculation. This is a required entry.

Field Alias 

Enter a brief alternate name that you can use in requests as a synonym for the field name 
to minimize typing. (Length and format rules apply to aliases.) This is an optional entry.

If you create a report, the field name appears as a column heading unless you have 
specified an alternate title for the field. Aliases cannot be used as column titles.
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Note: Aliases are not available for virtual fields and are not used in the Maintain 
language.

Field Property 

Choose one of the following, to be used in conjunction with Field Reference: 

PARENT_OF 

Identifies this field as the parent of the referenced field in a hierarchy. This attribute 
can be specified on every field. Therefore, multiple hierarchies can be defined in 
one Master File. However, an individual field can have only one parent. If multiple 
fields have PARENT_OF attributes for the same hierarchy field, the first parent 
found by traversing the structure in top-down, left-to-right order is used as the 
parent. 

CAPTION 

Signifies that this field contains a descriptive caption that can be displayed in place 
of the hierarchy field values in a report. For example, if the employee ID is the 
hierarchy field, the last name may be the descriptive text to be displayed in place of 
the ID. 

 A caption can be specified for every field, but an individual field can have only one 
caption.  If multiple fields have CAPTION attributes for the same hierarchy field, the 
first parent found by traversing the structure in top-down, left-to-right order will be 
used as the caption. 

You can assign either PARENT_OF or CAPTION to a field in the data source or to a virtual 
field defined in the Master File.

Field Refererence 

If PARENT is the field property, the reference is the child field in the hierarchy to say 
which field this is the parent of. 

If CAPTION is the field property, the reference is the child field in the hierarchy to show 
which field to apply the caption to.

Index (Standard B-tree) 

You can index the values of a field to enhance data retrieval performance. To do so, 
select the Index check box when you add a field and before you add the data. An index 
is an internally stored and maintained table of data values and locations that enhance 
the performance of data retrieval. A Master File can have several associated indexes, 
but the combined total of indices and segments cannot exceed 64.

This feature is not available for virtual fields.

Tip: You can turn on the index after adding data to a field, however, you will have to use 
the Rebuild Index option to create the index. For details, see Chapter 5, Adding Data 
and Rebuilding FOCUS Data Sources.
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Format 

The field Format option is a required entry. It enables you to assign a format to the field 
based on the values the field will hold. The options are: Alphanumeric, Numeric 
(Floating Point, Integer, Decimal, Packed), and Date.

The input fields in the window adjust based on the format you select:

• For fields with Numeric formats, you can assign display options that determine 
how the field will be displayed in reports.

• For fields with a Date format, you assign display options that determine how the 
field will be displayed in reports. You can also assign century values to the date 
field. For more information, see Assigning Century Values in a Master File on 
page 2-8.

Maintain users should see the WebFOCUS Maintain documentation for detailed 
information about available formats (data types) and associated display options.

Tip: The term Format in the Master File Editor is equivalent to the term Type in the 
WebFOCUS Maintain Type wizard.

Length (1-256) 

Indicate the maximum number of positions an alphanumeric or numeric field can 
contain.

Allow Missing Data (do not substitute blanks or zeros) 

If a segment instance exists but no data has been entered into one of its fields, that field 
has no value. This absence of data is represented as a null value or missing data. You 
use the Allow Missing Data check box to request the display of a missing data value for 
a field when read from a data source or written to a data source.

Not supported for virtual fields. See Master File Tab: Missing (Virtual Field Level) on 
page 2-30.
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Reference Master File Tab: Display (Field Level)

This tab provides optional parameters that you can supply for a field. These parameters 
make it easier for you to describe the field to users. They affect reports, not data 
maintenance transactions.  

When a field is selected in the left (Master File) frame, the Display tab has the following 
fields/options:

Column Title 

 Optional. Enter a title of up to 64 characters. This entry will appear as the column title 
on reports instead of the field name.

Help Message 

Optional. Enter a line of text (up to 78 characters) to provide additional information 
about a field on a form.

Description 

Optional. Enter descriptive text (up to 43 characters) to identify the data field. It can be 
displayed in Fields lists and on the status bar.

Field descriptions also appear as bubble help in OLAP-enabled reports. If you do not 
include a description, bubble help shows the field name (column title). For information 
on displaying bubble help in OLAP-enabled reports, see Creating Reports With Graphical 
Tools.
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Note:The Master File Editor supports 43 character descriptions. However, the Text 
editor and Command Console support descriptions of up to 78 characters. For the Text 
Editor, this includes starting and ending quotes.

Reference Master File Tab: Accept (Field Level)

You can control the acceptable values for a field by setting validation criteria. Since data 
fields can be addressed by several procedures, setting validation criteria in a Master File 
eliminates the need to provide lists in each separate procedure.    

You can set validation criteria for Maintain and MODIFY procedures and for OLAP-enabled 
Master Files.

Within an OLAP-enabled Master File, validation criteria enable you to:

• Specify a list of acceptable data values for an OLAP-enabled field.

• Specify a range of acceptable data values for an OLAP-enabled field.

• Specify acceptable data values that match values contained in an external flat data 
source (ddname option).

If you set validation criteria for a field, your project will allow only certain incoming values 
for the field when it is displayed on a form. If a user enters an unacceptable value for the 
field, a list of acceptable values will be displayed from which the user can make a selection.
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The Accept tab displays the following options for setting validation criteria:

Type 

None 

Indicates that you do not wish to set validation criteria. A user can enter any value 
within the limitations of the field’s format. This is the default setting.

LIST of values 

Enter a list of valid values. A user can only enter a value from this list. You can also 
use this list to populate radio buttons, combo boxes, and list boxes.

RANGE of values 

Enter a range of valid values (for example, a range for an integer might be 100-200). 
A user can only enter a value within the defined range.

FIND values in file 

Supply file and field names that instruct FOCUS where to search for a data source 
and for a list of acceptable values. You supply the field name of the data field for 
which the validation criteria are being assigned, the file name of the target FOCUS 
data source where the field can be found, and the field name of the target data 
field that contains the validation criteria.

Note: Find is only available for FOCUS data sources and does not apply to 
OLAP-enabled Master Files. Note also that, in the Maintain environment, Find is not 
supported when developing a Master File.

OLAP-enabling a Master File

You OLAP-enable the Master File by creating dimension(s) at the field level and associating 
fields with each dimension. In addition, you can specify acceptable values for each 
dimension member (field). For details on the syntax for dimensions (WITHIN) and 
controlling acceptable values (ACCEPT), see Describing Data With WebFOCUS Language.

Note: OLAP is a reporting facility; it is not relevant to data maintenance projects.

Master Files can be modified to support Online Analytical Processing (OLAP). OLAP enables 
you to drill down or roll up on hierarchical data, pivot fields from columns to rows (or vice 
versa), and slice-and-dice information by filtering or querying data sources based on 
specified criteria thresholds.  
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Reference Master File Tab: OLAP (Field Level)

When a field is selected in the left (Master File) frame, the OLAP tab has the following fields/
options for specifying a dimension:  

Within

Is the name of a field to be included in a dimension.

Make root dimension

Specifies a field as the root dimension.

Creating a Dimension in a Master File
In order for you to OLAP-enable a Master File, you must create a dimension. A dimension is 
a group or list of related fields, called elements. For example, a typical hierarchy of sales 
regions could be defined in a Master File as the GEOGRAPHY dimension and could include 
the fields (in descending order) Region, State, and City. Region, the highest level in this 
hierarchy, would contain a list of all available regions within GEOGRAPHY. State, the second 
highest level in the hierarchy, would contain a list of all available states within region, and 
so on. Dimensions can be defined in the Master File for any supported data source.    
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A combination, or matrix, of two or more dimensional hierarchies in an OLAP-enabled data 
source is called “multi-dimensional.” For example, although products are sold within states 
they need not be grouped in the same dimension as states. Rather, the elements Product, 
Category, and Product Name would more commonly be grouped in a dimension called 
PRODUCT. State would be a member of the GEOGRAPHY dimension that might also include 
Region and City. Then, these dimensions are combined in a matrix so that the intersections 
of their criteria provide specific values—for example, sales for coffee in the Northeast 
region.

For details on the WITHIN syntax that defines dimensions, see Describing Data With 
WebFOCUS Language.

Procedure How to Create a Root Dimension in a Master File

1. Select a field in the Master File hierarchy (left pane), then click the OLAP tab.    

2. Type the dimension name in the Within input box, then click the Make root dimension 
check box. Note that the dimension name must start with a letter and can contain up to 
66 characters, which can be any combination of letters, digits, underscores, or periods. 
Avoid using special characters and embedded blanks.

FOCUS creates the dimension. You can now associate fields to the dimension.For details, 
see Associating Fields to a Root Dimension on page 2-28.

Note: When you type the dimension name, the dimension is automatically created. To view 
the change in the Master File, right-click the root segment and choose Show Master Text 
from the shortcut menu or open the Master File in the text editor.

Associating Fields to a Root Dimension
To OLAP-enable a Master File, you must associate fields with the dimension you created. 
This association identifies the fields as part of the dimension. Note that a field may be 
associated to only one dimension.  

If Master Files have been joined, you can associate a field from one Master File to a 
dimension in the other. The field from the joined Master File will be active in the dimension 
when the join is run.

You can specify acceptable values for each field you associate with a dimension using the 
Accept tab. For details, see Master File Tab: Accept (Field Level) on page 2-25.

Procedure How to Associate a Field to a Root Dimension

1. Select the field in the Master File hierarchy (left pane) to which you want to associate to 
a dimension, then click the OLAP tab.  

2. In the Within input box, type the name of the dimension to which the field should be 
associated.
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When you type the dimension name, the dimension is automatically created. To view the 
change in the Master File, right-click the root segment and choose Show Master Text from 
the pop-up menu or open the Master File in the text editor.

Adding Virtual Fields to a Segment

This feature is convenient when you want to use a virtual field in many different procedures 
that use the same data source; it saves you the effort of defining the field in each procedure.

The procedure for adding a virtual field to a Master File is similar to the procedure used to 
add any field. For both, you must specify a field name and a field format. However, the 
difference between describing a virtual field and a regular field is that you must define the 
field by using at least one other real field that belongs to the same segment. You use this 
real field to build an expression that defines the values a virtual field will hold. An 
expression enables you to combine fields, constants, pre-defined functions, and operators 
into one statement that produces a single value.

Procedure How to Describe a Virtual Field in a Segment

1. In the Master File hierarchy (left pane), select the segment in which you want to add a 
virtual field, then perform one of the following actions:  

• Right-click and select New, then choose Defined field from the cascading menu.

• Click the New Defined Field button on the toolbar.

• Select Defined field from the Insert menu.

The General, Display, and Missing Data tabs open in the right pane.

2. In the General tab (Field level): 

a. Type a name for the field, using uppercase characters, in the Field Name input box 
(required).

b. Type the syntax for the expression in the Expression input box (required).

or

Click the Assist button to create an expression using the Define Expression 
Assistant. For details, see Defining Expressions for Virtual Fields on page 2-31.

The expression will display in the Expression input box. For additional information, 
see Creating Reports With Graphical Tools. 

A virtual field is a field whose value is not stored in the data source but can be calculated 
from the data that is there. You can create a virtual field in your Master File. The field is 
available whenever a user accesses the corresponding data source.   
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c. Select a format or data type, then specify the length, the decimal places (if 
applicable), and any display options for the field. The data type (numeric, 
alphanumeric, date), field length and, for some numeric formats, decimal places 
are required parameters; display options are not. You can also assign century 
values to virtual fields in Master Files. Maintain users should see the WebFOCUS 
Maintain documentation.

3. Click the Display tab if you wish to include a column title and help message for the field. 
Type the text in the appropriate input box.Master File Tab: Display (Field Level) on 
page 2-24. 

4. Click the Missing Data tab if you want to enter a missing value for the field. See Master 
File Tab: Missing (Virtual Field Level) on page 2-30.

5. Click the OLAP tab to create a dimension and associate it to the field you selected. After 
you create a dimension you can associate other fields to it. See Master File Tab: OLAP 
(Field Level) on page 2-27.

Reference Master File Tab: Missing (Virtual Field Level)
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When a virtual field is selected in the left (Master File) frame, a Missing Data tab is available 
with the following fields/options:   

Allow Missing Data 

Sets the default value for missing data to null for a virtual field. When you activate this 
option, Developer Studio or Maintain can distinguish a null value from an intentionally 
entered blank or zero. When this option is selected, if a field with a missing value is 
read, that value is ignored when an aggregating calculation, such as averaging, is 
performed. When you select Allow Missing Data the following associated options are 
available:

Some 

Indicates that if at least one field in the expression has a value, the virtual field has a 
value (the fields missing values are evaluated as 0 or blank). If all of the fields in the 
expression are missing values, the virtual field is missing its value. This is the 
default.

All 

Indicates that if all the fields in the expression have values, the virtual field has a 
value. If at least one field in the expression is missing a value, the virtual field is 
missing its value.

With 

Field 

Associates the virtual field with a data source field in a specific segment.

Segment 

Identifies the segment that contains the field with which the virtual field is 
associated.

Defining Expressions for Virtual Fields
You can type the syntax for the expression directly into an input box in the General tab, or 
you can access the Define Expression Assistant, which will help you build the field’s 
expression.   
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Reference Define Expression Dialog Box

The Define Expression dialog box is used by the Master File Editor to create expressions for 
virtual fields, and by the WebFOCUS Maintain Language Wizard to create WHERE 
expressions for NEXT commands. The dialog box displays a list of available data source 
fields, functions (Master File Editor only), variables (Language Wizard only) and logical and 
mathematical operators you can use to build an expression.   

Expression box 

Location for typing an expression. You can add data source fields from the Fields tab, 
variables from the Variables tab (Language Wizard only), functions from the Functions 
tab (Master File Editor only), and numbers and operators from the calculator as you 
type.

Calculator 

Provides numbers and operators that you can use to create expressions.

Fields tab 

Lists the data source fields that you can use in creating an expression.

Variables tab (Language Wizard only) 

Lists the variables that you can use in creating an expression.

Functions tab (Master File Editor only) 

A function is a program that returns a value. This tab lists the built-in functions that you 
can use to derive the value of a temporary field. For details, see the documentation on 
built-in functions available from your reporting or Maintain environment.
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Adding Group Fields to a Segment

Note:In the Maintain environment group fields are supported in a Master File as long as 
they are not group keys, that is groups that are actual fields, as supported by VSAM. If you 
create a group field in the Maintain environment, the group will not be visible, only the 
fields that make up the group will be visible.

Procedure How to Add a Group Field to a Segment

1. In the Master File hierarchy (left pane), select the segment in which you want to add a 
group field and then perform one of the following actions: 

• Right-click and select New, then choose Group Field from the cascading menu.

• Click the New Group Field button on the toolbar.

• Select Group Field from the Insert menu.

The General and Display tabs appear in the right pane.

2. In the General tab, type a name for the group field in the Group Name input box 
(required)., Notice that the default format is A20 and the field names in the group 
appear in the Fields Within Group box at the bottom of the tab window.

3. Click the Display tab to include a column title, help message, or a description for the 
field. To include any of these characteristics, type the text in the appropriate input box.

4. Click a field in the group field hierarchy and supply the required information in the 
General, Display, Accept, and Maxvalue tab (Fusion only) windows. For information 
about these tab windows, see How to Describe a Field in a Segment on page 2-19.

Once you have supplied information for the required parameters and any optional 
parameters for each field, the group field definition is complete. You can now add other 
fields (or group fields) to the current segment, add fields to another segment, or create a 
new segment.

Procedure How to Add a New Field to a Group Field

Click the group field to which you want to add a new field and perform one of the following:  

• Right-click and select New, then choose Field from the cascading menu.

• Click the New Field button on the toolbar.

• Select Field from the Insert menu.

You can assign a unique name to multiple fields to create a group field. A group field is 
created by two or more alphanumeric fields, physically next to each other. A group field 
provides an efficient means for grouping similar or logically connected fields that will be 
accessed as a single unit, but do not warrant a separate segment. 
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The General, Display, Accept, and OLAP tabs display in the right pane. Supply the required 
information in each of the tab windows.

Procedure How to Add an Existing Field to a Group Field

1. Click the field you want to add to the group field. 

2. While holding the left mouse button down, drag the field and drop it on the group field 
name.

The field is added to the group field.

Procedure How to Delete a Group Field From a Segment

Right-click the group field, then select Delete. 

Procedure How to Delete a Field From a Group Field

Right-click the field, then select Delete. 

Reference Master File Editor: Group Tab

The Group tab enables you to define a group field.   
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This dialog box contains the following options:

Group Name 

Is the name of the group field.

Index (Standard B-tree) 

Specifies that you wish to index the values of this field to enhance data retrieval 
performance. For more information, see Master File Tab: General (Field Level) on 
page 2-21. 

Format 

Contains the format for the group field. Since the group field is made by concatenating 
together several other fields, the Master File Editor determines what this format needs 
to be. For example, if the group field has two alphanumeric fields in it, each 20 
characters long (A20), then the group field must be alphanumeric and 40 characters 
long (A40). The group field is always alphanumeric, regardless of what the fields that 
make it up are.

Fields within group 

Contains the names and formats of the fields in the group field.

Creating a Cross-Reference

A Cross-reference wizard accessed from the Master File Editor guides you through the 
process, in which you must select the host field, the target field, and the type of 
cross-reference you want.

There are two types of cross-references that you can create: one-to-one or one-to-many:

• A one-to-one cross-reference creates a unique relationship between the source and 
target segments, meaning any instance of the source segment can have at most one 
matching instance in the target segment. If multiple matching instances exist in the 
target file, only one instance is retrieved.

• With a one-to-many cross-reference, a non-unique relationship is created between the 
source segment and target segment resulting in the possibility of multiple matching 
instances in the target segment.

A cross-reference identifies matching instances from two data sources. You can create a 
cross-reference between two separate data sources with corresponding data types and 
values in one or more fields. Once the cross-reference is created, matching data from the 
second (target) file will be retrieved when a segment instance from the first (source) file is 
retrieved.   
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In addition, the Cross-reference wizard allows you to choose one of the following options:

• Remembered to store the locations of all matching target instances in the source data 
file.

• Limit to current segment to restrict the cross-reference to the named target segment; 
with this option in effect, the entire cross-referenced data source structure is not 
involved in the logical data source.

Procedure Using the Cross-Reference Wizard

1. Click on the host segment or field in the Master File for which you wish to create a 
cross-reference.   

2. Click  (New Cross-Reference) on the Master File Editor toolbar to activate the wizard.

3. If you are creating a cross-reference from a segment, the wizard will ask you to enter 
your cross-reference specifications in a series of windows.

• Type or browse for the target file to cross-reference. Select a target field from the 
Available Target Fields list, then click Next.

• Select the type of cross-reference you would like to create, then click Next. Note 
that two additional segment types (KL and KLU) appear when creating a 
cross-reference within a cross-reference. For a description of each cross-reference 
type, see Master File Tab: General (Cross-reference Segments) on page 2-37.

or

If you are creating a cross-reference within a cross-reference, the wizard will ask you to 
choose the type of child cross-reference that you would like to create. Select a Linked 
segment type and a Linked Segment, then click Next.

Tip: If necessary, you can click Back to modify your selections.

4. Click Finish.

Note: If you are creating a new Master File in the Maintain environment, the New 
Cross-Reference Wizard button on the toolbar will not be active until you save the Master 
File on a server.
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Reference Master File Tab: General (Cross-reference Segments)

When you create a cross-reference you can view information about that cross-reference 
when you highlight it.                

Cross reference file 

A physical Master File.

Target field 

A key field from the cross-reference file that matches a field in your data source.

Keyed Unique (KU) 

Indicates that this is a cross-referenced segment joined to the data source using a static 
join defined in the Master File, and has a one-to-one relationship to the host segment 
(that is, it is a unique segment).

Keyed Multiple (KM) 

 that this is a cross-referenced segment joined to the data source using a static join 
defined in the Master File, and has a one-to-many relationship to the host segment.

Keyed thru Linkage (KL)  

Indicates that this segment is described within a Master File defined join as descending 
from a KM, KU, DKM, or DKU segment in a cross-referenced data source, and has a 
one-to-many relationship to its parent.

This segment type is a result of creating a cross-reference within a cross-reference.
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Keyed thru Linkage Unique (KLU) 

Indicates that this segment is described within a Master File defined join as descending 
from a KM, KU, DKM, or DKU segment in a cross-referenced data source, and has a 
one-to-one relationship to its parent (that is, it is a unique segment).

This segment type is a result of creating a cross-reference within a cross-reference.

Dynamic Keyed Unique (DKU)

Indicates that this is a cross-referenced segment joined to the data source using a 
dynamic join defined in the Master File, and has a one-to-one relationship to the host 
segment (that is, it is a unique segment).

Dynamic Keyed Multiple (DKM)

Indicates that this is a cross-referenced segment joined to the data source using a 
dynamic join defined in the Master File, and has a one-to-many relationship to the host 
segment.

Maintain users should see the WebFOCUS Maintain documentation for additional 
information on creating cross-references.

Setting Up Security for a Master File

• User Level. You specify the DBA and user passwords for the data source. The user 
password represents a user who has access to that data source. When you specify a 
user password, you must also set at least the type of file access: read, write, read/write, 
update. Each user’s security can be further limited by restricting access to segments, 
fields, or field values. For more information, see Restricting Access to Segments, Fields, 
and Field Values on page 2-43., Once a user password has been established, you can 
apply the same restrictions to multiple users. For more information, see Applying 
Security Restrictions for Multiple Users on page 2-43.

When security is specified, the Database Administrator or user must enter a password to get 
access to the data source. When the DBA or user no longer has access to the data source, 
you can delete their security.

Before adding any type of security to a data source, the Database Administrator must be 
aware of certain DBA guidelines. 

You can secure Master Files on a file-by-file basis. For each data source, security can be 
maintained at two different levels.      

• Database Administrator Level. You specify the Database Administrator (DBA) 
password for the data source. The DBA has unlimited access to the Master File and data 
source and can set up or change security restrictions for individual users. Only the 
Database Administrator can encrypt (scramble) or decrypt (unscramble) a data source. 
For more information, see Encrypting and Decrypting a Master File on page 2-41.
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Procedure How to Set Up Security for the Database Administrator

1. In the Master File hierarchy (left pane), click the data source path.       

The General and DBA tabs open.

2. Click the DBA tab, then type the DBA password in the DBA Password box.

Note:When the password is created and the cursor is in that field, you can right-click 
and use the edit options to undo, select all, cut, copy, paste, or delete the password.

3. Save the Master File with the DBA password.

Procedure How to Set Up Security for the User

1. Set up security for the Database Administrator.       

2. Tab to the Users box, then type the user password., The File Access, Access Restrictions, 
and Same Restriction options are activated.

3. Select the type of file access from the File Access group.

Note: When the password is created and the cursor is in that field, you can right-click 
and use the edit options to undo, select all, cut, copy, paste, or delete the password.

4. Select the type of restriction — segment, field, and/or field value — from the Access 
Restrictions group, then select the type of access for each. For details, see Restricting 
Access to Segments, Fields, and Field Values on page 2-43.

5. Save the Master File with the user password and restrictions.

Reference DBA Guidelines

You can ensure that the security restrictions you place on Master Files are correct by 
adhering to these guidelines.     

• Every file with access limits must have a DBA password.

• No segment, field, or field value restrictions may be specified at the Database 
Administrator level. The Database Administrator should have unlimited access to the 
data source and all cross-referenced data sources.

• Once security restrictions have been applied, the Database Administrator should 
conduct thorough testing of every restriction before the data source is used. It is 
particularly important to check field values to make sure they do not contain errors. If 
they are in error, user access to the fields’ data will be unnecessarily restricted.

• All groups of cross-referenced data sources must have the same security restrictions.

• You must have a DBA password to encrypt and decrypt or restrict existing data sources.

• The Database Administrator can change any type of security restriction.
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• Access levels effect what fields users can access. The Database Administrator must 
consider what commands each user will need. If a user does not have access rights, that 
user will receive an error message.

Reference Master File Tab: DBA (File Level)

For detailed information about Data source Administrator (DBA), see Setting Up Security for 
a Master File on page 2-38.       

When you select the path in the Master File hierarchy, the DBA tab is available with the 
following fields/options:

DBA Password 

Enter your DBA password of up to 8 characters. This is the password of the DBA who 
will be creating and maintaining the current data source. The DBA has full access to the 
data source and the corresponding Master File, controls the access rights of other users, 
and has encryption privileges. See Encrypting and Decrypting a Master File on page 2-41.

DBA File 

Enter the name of the Master File that contains your DBA security restrictions. Other 
Master Files can use the DBA security restrictions in this Master File.
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Users 

Enter the passwords (up to eight characters) of users to whom access rights will be 
granted for the current data source.

Same Restriction: User Same as 

If multiple users require the same access rights, indicate the user whose access profile 
you wish to apply and the new user to whom you wish to apply it. See Applying Security 
Restrictions for Multiple Users on page 2-43.

File access 

Choose Read access for full viewing rights.

Choose Write access to permit additions/changes to the data source.

Choose Read/Write for both of the above.

Choose Update access to make changes to field values.

Access Restrictions 

Name , User name.

Access , Type of access restriction.

Value , Value to restrict access to.

Segment, Field, Value 

Choose Segment to grant access to all or individual segments.

Choose Field to grant access to all or individual fields.

Choose Value to limit access to values that meet a test condition. See Restricting Access 
to Segments, Fields, and Field Values on page 2-43.

Encrypting and Decrypting a Master File

Encryption at the data source level scrambles the entire contents of that Master File so it is 
unreadable. When you encrypt a Master File, you can decrypt it. Decrypting unscrambles 
the contents to its readable state.

Within a Master File, you can encrypt a segment. For details, see Master File Tab: General 
(Segment Level) on page 2-13.

Before you can encrypt or decrypt any Master File or segment, you must specify the DBA 
password. If you do not specify a DBA password, you will not be able to encrypt or decrypt.

You may use the Encrypt and Decrypt options to scramble and unscramble some or all of 
the contents of a data source. When you encrypt Master Files, they are secure from 
unauthorized examination.       
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Procedure How to Encrypt a Master File

1. At the file level in the Master File hierarchy (left pane), click the DBA tab and type the 
DBA password in the DBA Password box.    

2. Save the Master File with the DBA password.

3. On the Command menu, choose Security, then select Password., A dialog box opens.

4. Type the DBA password, then click OK.

5. On the Command menu, choose Security, then select Encrypt.

The Master File is encrypted.

Procedure How to Decrypt a Master File

1. On the Command menu, choose Security, then select Password.  

A dialog box opens.

2. Type the DBA password, then click OK.

3. On the Command menu, choose Security, then select Decrypt.

The Master File is decrypted.

Procedure How to Encrypt a Segment

1. Make sure a DBA password has already been assigned. For details, see How to Set Up 
Security for the Database Administrator on page 2-39.    

Note: Encryption will not occur properly if the DBA password has not been set prior to 
the encryption of a segment.

2. Select a segment in the left pane.

3. Select the Encrypt check box next to the Segment Name in the General tab.

4. You can now add records to the segment.

Selecting the Type of Access
When you assign a user password, the type of file access and access restrictions become 
available. You must specify at least the type of access the user is permitted to have for the 
data source. The type of file access can be specified in the File Access group on the DBA tab. 
In this group, there are four file access options:        

• Read. Allows the user only to read (to view) the data source.

• Write. Allows the user only to write (to add or to make changes) to the data source.

• Read/Write. Allows the user to read and write to the data source.

• Update. Allows the user to update (to make changes to) existing field values.
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The type of file access determines what a user can do to the entire data source:

• If you specify only the type of file access, the user will have the specified access to the 
entire data source.

• If you want to impose additional limitations you can restrict access to segments, fields, 
and/or field values. See Restricting Access to Segments, Fields, and Field Values on 
page 2-43.

Restricting Access to Segments, Fields, and Field Values
You can restrict access to segments, fields, and field values in a Master File by specifying 
Access Restrictions for a user. When you specify what is to be restricted — segment, field, 
and/or field value — you can then specify the type of access that will be restricted. For 
fields, you can also specify whether or not you want the field to be displayed. For field 
values, you are required to enter a test condition.       

• Segments. You specify the type of access for individual segments or all segments.

• Fields. You specify the type of access for individual fields or all fields. You can also 
specify not to display the data in that field using NoPrint. If you specify NoPrint for a 
field, the data will appear as blanks for alphanumeric format or zeros for numeric 
format whenever the user tries to retrieve it.

• Field Values. You specify the type of access (read or write) and the test condition. The 
user is restricted to using only those values that satisfy the test condition.

Applying Security Restrictions for Multiple Users
You can specify restrictions for one user and apply the same restrictions to other users. This 
helps when you want to set the same restrictions for a group of users.     

Procedure How to Apply Previously Defined Restrictions to Another User

1. On the DBA tab, type the new user password in the Users box, then press Enter.      

The Same Restrictions group is activated.

2. In the Same Restriction group, click the User Same as check box.

3. Click the arrow on the drop-down combo box, then select the user with the security 
restrictions that would apply to the new user., Security restrictions from the user in the 
User Same as box are applied to the new user. You can apply the security restrictions to 
other users by repeating steps 1 to 3.

Note: You must have created at least one user security restriction to apply security 
restrictions to multiple users.
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Deleting a DBA or User’s Password

Procedure How to Delete a User’s Password

1. On the DBA tab, type the user password in the Users box.  

or

Double-click on the user name so it displays in the Users box.

2. Right-click and select Delete or press Delete on the keyboard., The DBA dialog box 
opens.

3. Select Yes.

If you delete the user based upon whom you have assigned security restrictions for other 
users, you must reset security restrictions for all users attached to the user you deleted.

Procedure How to Delete a DBA Password

Note: Deleting a DBA’s security will delete all users’ security for that data source.  

1. On the DBA tab, type the DBA password in the DBA Password box.

2. Right-click and select Delete or press Delete on the keyboard., A Warning dialog box 
opens.

3. Select OK.

Viewing the Master File Layout

• The file folder hierarchical structure displays in the left pane when you open a Master 
File. It shows the directory path and the root segment, followed by either fields, or 
other segments with fields.

• The branch structure shows the directory path, root segment, and any other segments 
in that Master File. The branch structure does not show fields in the Master File, 
however it provides a clearer view of the relationships between segments.

Procedure How to View a Master File

Click the Show Layout Window button on the toolbar to display the Master File in a branch 
structure. 

You can delete a DBA or user’s security when it is no longer needed.      

You can view a Master File in two ways: 
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Procedure How to Open a Master File in the Editor (Reporting Environment)

1. From an open project, right-click the Master Files folder and select New or choose New 
from the File menu. 

The New Master File dialog box opens.

2. Choose a Master File Source, then select a Master File from the Master File list.

3. Click OK.

The Master File you selected opens in the editor.

Previewing and Printing a Master File

• Show Master Text. Allows you to display only the Master File as read only text.

• Print Preview. Allows you to display the Master File as read only text formatted for 
printing.

• Editor (Reporting Environment only). Allows you to display the Master File or Access 
File as read and write text. To view a Master File in the Text Editor you must exit the 
Master File in the Master File Editor, then reopen it in the Text Editor.

You can also print the code for a Master File using the Print option on the File menu.

Procedure How to View a Master File as Read-Only Text

1. From the open Master File, right-click the path (Reporting environment) or name 
(Maintain environment) above the root segment in the hierarchical pane. 

2. Select Show Master Text.

The file opens as code in the File As Text (Read-Only) dialog box.

Procedure How to Preview a Master File

1. From the open Master File, select Print Preview from the File menu. The Master File 
opens as code in a print preview window. 

2. In this window you can zoom in and out, view two pages at once, view the next or 
previous page, print the Master File, and/or close the print preview window and return 
to the Master File Editor.

You can preview and/or print a Master File to view its code. The editor provides the 
following options:  
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Procedure How to Print a Master File as Text

Note: You can also print the Master File from the Print Preview option. 

1. From the open Master File, select Print from the File menu., The Print dialog box opens.

2. Set the Printer, Print Range, and Copies options and click OK., The Master File prints as 
code on the printer you designated. The printed document shows the Master File path 
and the date and time it was printed.

Note: In the reporting environment, you can also print a Master File as text by right-clicking 
the Master File and selecting Print.
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CHAPTER 3

Creating Synonyms

Topics:

• Creating Synonyms

• Creating Synonyms for OS/390 MVS 
Using the Synonym Wizard

Before you can create a procedure that reports against a 
data source, your project must understand how the data is 
organized. To obtain this information, your project reads a 
data source description or a synonym for that description. 
A synonym is an alias for a data source, which tells the 
server where to find tables and how they are described. The 
data source description or synonym consists of two files: 

• A Master File, which contains field names and formats 
for the columns in the data source. The synonym also 
contains an alias for the data source.

• An Access File, which contains additional information, 
including the real name and location of the data 
source.

If these synonyms do not already exist on the server, you 
can quickly create them using the Server Console. For 
details, see Creating Synonyms on page 3-2.

To create synonyms for an OS/390 MVS platform, you must 
use the Synonym Wizard. For details, see Creating Synonyms 
for OS/390 MVS Using the Synonym Wizard on page 3-11. 

The appropriate tool to create synonyms will be launched 
for each platform.

Note: To make use of the synonyms you create, the 
WebFOCUS Reporting Servers must be configured to use 
APP PATH logic. For details about APP PATH, see Creating 
Synonyms on page 3-2 and the Developing Reporting 
Applications manual.
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Creating Synonyms

You must configure a data adapter using the Server Console before you can create a 
synonym. See How to Configure a Data Adapter Using the Server Console on page 3-2.

Note: You must make sure that the WebFOCUS Reporting Server is configured to use APP 
PATH logic. Synonyms are stored within folders based on the APPROOT setting in the 
WebFOCUS Reporting Server. The default setting for APPROOT is install_drive/ibi/apps. This 
is the default path defined as the alias on the WebFOCUS Reporting server. For more 
information about APP PATH, see Developing Reporting Applications. Cataloged Path 
(EDAPATH) is not supported.

Procedure How to Configure a Data Adapter Using the Server Console

1. From Developer Studio, go to the Command menu and select Server Console.

The Server Console opens.

2. Click the Data Adapters link.

3. Open the Add folder to expand the list of available data adapters.

4. Click the (+) sign next to the data adapter you want to configure.

5. Click the data adapter you want to configure. 

A list of fields is displayed in the Database Configuration screen.

6. Type the required parameters in the fields.

7. Click Configure.

Note: The configuration information for data adapters is stored in two configuration 
files—EDASPROF.PRF and EDASERVE.CFG.

The data adapter is now listed under the Configured folder on the left side of the Server 
Console window. 

For details about the Server Console and configuring data adapters, see the iWay Server 
Administration for UNIX, Windows, OpenVMS, OS/400, OS/390, and z/OS documentation.

Whether you are developing projects in the local server environment (the Projects on 
localhost area), or running procedures from the Data Servers area under WebFOCUS 
Environments, you will need to ensure that the WebFOCUS Reporting Server has the data 
source descriptions or synonyms it requires to locate and interpret your data sources. You 
can create synonyms using your WebFOCUS Reporting Server’s Server Console.
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Adding a Remote Server
If you prefer to use a WebFOCUS Reporting Server other than the one installed locally on 
Developer Studio, you can add a remote server. You can then create and store synonyms on 
the remote server and then report on its data.  Begin by determining which WebFOCUS 
Reporting Server accesses the data you wish to report on, then add it to your local 
WebFOCUS Reporting Server. If you create a synonym on a remote server, it will become 
available in your local environment. 

Procedure How to Add a Remote Server

1. From Developer Studio, go to the Command menu and select Server Console.

The Server Console opens.

2. Click the Remote Servers link on the left side of the Server Console window.

3. Click the Remote Servers folder.

4. Open the Add folder to expand a list of communication protocols.
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5. Choose a protocol to use for connecting to the remote WebFOCUS Reporting Server. 
For most Windows and UNIX machines, you can connect using TCP.

A list of fields is displayed in the right pane of the Server Console window where you 
must supply required information for the remote server based on the protocol that was 
selected.

6. Type the required parameters in the fields.

7. Click Save. For information about the configured remote servers, place your cursor over 
the server’s name or click the ODIN.CFG link to view all configured remote servers.

Note: For TCP or HTTP connections, be sure to change the Service field to the 
appropriate port or service for the remote WebFOCUS Reporting Server. The default 
TCP port is 8120, not 8100. The default HTTP port is 8121, not 8101.

8. The remote server is now listed under the Configured folder on the left side of the 
Server Console window. You can test the connection by clicking the server and 
selecting Test from the menu.
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Procedure How to Create a Synonym From the Projects on Localhost Folder

You must create a data adapter before you can create a synonym. For details, see How to 
Configure a Data Adapter Using the Server Console on page 3-2.

Note: Synonym names can have a maximum of 64 characters, but spaces and special 
characters are not supported. 

1. Right-click a Master File folder under Projects on localhost, select New, and then 
Synonym.

The Server Console window opens at the Metadata page.

2. By default, the tree under the Add folder is expanded and shows all remote servers and 
configured data adapters.
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3. Click a connection name under a configured data adapter in order to start the Create 
Synonym process.

After synonyms have been created, the project where the Create Synonym tool was 
launched is displayed unde the Configured folder. Master Files will be listed for the 
selected project.

4. Click a synonym to see a list of available options.

Relevant options are:

Sample data 

Click this option to run a query against the data source and view records.

Edit Master File 

Click this option to edit synonym code and click Save to save your changes.

Refresh 

Click this option to recreate synonyms in order to update field information while 
preserving the old synonym’s title, description, usage, virtual field, and DBA 
information. This feature also synchronizes the Master File with the table on which 
the synonym is based.

Drop 

Click this option if you want to delete a Master File.

Procedure How to Create a Synonym From the WebFOCUS Environments Folder

You must configure a data adapter before you can create a synonym. For details, see How to 
Configure a Data Adapter Using the Server Console on page 3-2.

For all platforms with the exception of OS/390 MVS, you will create synonyms from the 
Server Console’s Metadata page

Note: If your server is running on OS/390 MVS, you will launch the Synonym Wizard, which 
enables you to create synonyms for that specific platform. For more information, see How to 
Create a Synonym For OS/390 MVS Using the Synonym Wizard on page 3-12.

1. Open the Data Servers folder under WebFOCUS Environments.

2. Click the plus (+) sign next to a server name.

3. Open the Applications folder under a server.

4. Right-click an application, select New Data File, and then Create Synonym.

Note: You will only see folders based on the server’s APPROOT setting.

The Server Console window opens at the Metadata page.
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5. By default, the tree under the Add folder is expanded and shows all remote servers and 
configured data adapters.

6. Click a connection name under a configured data adapter in order to start the Create 
Synonym process.

Note: Synonym names can have a maximum of 64 characters, but spaces and special 
characters are not supported.

After synonyms have been created, the application where the Create Synonym tool was 
launched is displayed under the Configuration folder. Master Files will be listed for the 
selected application.

7. Click a synonym to see a list of available options.

Relevant options are:

Sample data

Click this option to run a query against the data source and view records.

Edit Master File

Click this option to edit synonym code and click Save to save your changes.

Refresh

Click this option to recreate synonyms in order to update field information while 
preserving the old synonym’s title, description, usage, virtual field, and DBA 
information. This feature also synchronizes the Master File with the table on which 
the synonym is based.

Drop

Click this option if you want to delete a Master File.

Procedure How to Select All Tables/Views

1. Click a configured remote server or data adapter.

2. Click the Select All/Tables Views radio button on the right side of the Server Console 
window.

3. Click the Select Tables button in order to retrieve all available tables from the remote 
server.
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You will see a window with tables similar to the one below:

4. Select the All radio button to create Master and Access files for all tables.

You can change a synonym name in the Default Synonym Name field by typing a new 
name in the field box. Otherwise, check specific tables to use for reporting.

The Master and Access files are placed in the project or application directory 
(drive:\apps\baseapp) where the Create Synonym tool was launched.

5. Click the Create Synonym button.
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It may take some time for the process to complete, but when the files are created, they 
appear on your local machine. You are then ready to create projects using your local 
WebFOCUS Reporting Server. When you create synonyms from the Projects on 
localhost folder, you can use them for local development. If you create them from the 
WebFOCUS Environments folder, tables are created on the remote server to launch the 
Create Synonym tool. If you want to add a remote server, see How to Add a Remote 
Server on page 3-3 for details.

Procedure How to Apply Filters by Name, Owner, and Table Type

1. Click a configured remote server or data adapter.

2. Click the Filter by Name, Owner, and Table Type radio button on the right side of the 
Server Console window.

You will see a window similar to the one below:
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3. Type information into the fields.

4. Click the Select Tables button in order to retrieve all available tables from the remote 
server.

The window shows the tables returned after you applied the filter:

5. Select the All radio button to create Master and Access files for all tables.

You can change a synonym name in the Default Synonym Name field by typing a new 
name in the field box. Otherwise, check specific tables to use for reporting.

The Master and Access files are placed in the project or application directory 
(drive:\apps) where the Create Synonym tool was launched.
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6. Click the Create Synonym button.

It may take some time for the process to complete, but when the files are created, they 
appear on your local machine. You are then ready to create projects using your local 
WebFOCUS Reporting Server. When you create synonyms from the Projects on 
localhost folder, you can use them for local development. If you create them from the 
WebFOCUS Environments folder, tables are created on the remote server to launch the 
Create Synonym tool. If you want to add a remote server, see How to Add a Remote 
Server on page 3-3 for details.

Creating Synonyms for OS/390 MVS Using the Synonym Wizard

Viewing Synonyms and Tables

The Synonym Wizard guides you through the creation process for one or more synonyms. 
The synonyms are created on the WebFOCUS Reporting Server in the current application. 
The new synonym appears in the Master Files folder from which the wizard is launched. 

Note: For FOCUS data sources, WebFOCUS uses the original Master Files stored on the 
server, therefore no synonyms are required.

For OS/390 MVS platforms, you must use the Synonym Wizard to create synonyms for use in 
reporting against other remote servers (or subservers) that are configured on the target 
server. You can also create synonyms against DB2, the only relational data source 
supported on MVS. 

You can use the Synonym Wizard to create a synonym for a data source on the WebFOCUS 
Reporting Server, based on the native schema that resides with the data. If the remote 
server is configured as a subserver to a hub server, the Synonym Wizard can generate a 
synonym on the hub server, including an Access File that identifies the location of the data 
on the subserver.
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Procedure How to Create a Synonym For OS/390 MVS Using the Synonym Wizard   

You can launch the Synonym Wizard for OS/390 MVS from the Data Servers area in the 
WebFOCUS Environments folder.

Note: Synonym names for MVS can have a maximum of 8 characters, but spaces and 
special characters are not supported. 

1. Open the WebFOCUS Environments folder and navigate to the Data Servers area.

2. Open the Applications folder under a server.

3. Right-click an application, select New Data File, and then Create Synonym.

The Synonym Wizard - Select Interface window opens, displaying a list of relational 
data sources that are available on the WebFOCUS Reporting Server you are connected 
to, or a list of subservers configured in this environment.
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The Synonym Wizard - Select Interface window displays a list of interfaces that are 
available on your server.

• The server configuration—as indicated by the server profile—determines which 
data adapters are listed as available. DB2 is shown if the adapter is configured on 
the remote server. EDA is shown if the remote server is configured to access other 
iWay Servers.

• The server configuration—as indicated by the server profile—determines which 
interfaces are available.

4. Click Next to continue.
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Selecting a Synonym Source
Select an interface, and click Next. 

The Synonym Wizard - Select Interface window displays.

Selecting a Database
Once you have selected the interface and server, some RDBMSs allow you to choose a 
database from which to display a list of tables.

Procedure How to Select a Database

1. Select the appropriate database if the adapter supports databases. 

2. Click Next.
3-14 Information Builders



Creating Synonyms
Applying Filters
1. Apply filters based on owners or table prefixes to limit the list of tables to be returned 

from the remote data source. (If you do not include selection criteria, the entire list of 
tables is displayed.) 

2. Click Next.
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Selecting Table/Views

1. Click Next.

The Synonym Wizard - Select Synonym Sources window displays. 

2. Click Next to continue.

Once you have selected a DBMS Interface, server, and database, the Synonym Wizard - 
Selection Criteria window displays.    
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Procedure How to Select Tables/Views for A Synonym Creation

1. Select the Table/View name.

2. Click Next to continue.

Procedure How to Select More Than One Table for Synonym Creation

1. Click the table for which you want to create the synonym. 

2. Use the Shift key to select contiguous tables or the Ctrl key to select non-contiguous 
tables. You can also use the Ctrl key to deselect a table.

3. Click Next to continue.
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Assigning Synonym Names

By default, the table name is used as the synonym name. If a synonym already exists for the 
specified name, it will not automatically be replaced by the new synonym.

The Synonym Wizard-Creation Options dialog box has the following options:

Overwrite Existing: As Specified 

Overwrites an individual existing synonym.

Overwrite Existing: For the Entire List 

Overwrites all existing synonyms.

Dynamic Columns: As Specified 

Creates a synonym without any columns. 

Dynamic Columns: For the Entire List 

Applies dynamic columns to all synonyms. This option is especially useful in a test 
environment that has a constantly changing data structure. 

The Synonym Wizard - Creation Options window displays the list of tables you have chosen 
for synonym creation.     
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Procedure How to Rename a Synonym

1. Click once on the synonym name to highlight it, pause, then click again. This activates 
the cursor and allows you to change the text. 

2. Type the new name for the synonym. 

Note: The synonym name can be up to 64 characters.

3. Click OK to continue.

Procedure How to Assign a Unique Prefix or Suffix to All Synonyms

1. Type a prefix in the Synonym Prefix entry box, or a suffix in the Synonym Suffix entry box. 

2. The synonym name changes to include the suffix or prefix you entered.

3. When all selections have been made, click Finish.
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The Synonym Wizard - Generate Synonyms window displays.

4. Click OK to generate synonyms. 

The new synonyms are created in the folder where the Synonym Wizard was launched.

Procedure How to Refresh Synonyms

You can recreate synonyms in order to update field information while preserving the old 
synonym’s title, description, usage, virtual field, and DBA information with the Refresh 
Synonym feature. This feature also synchronizes the Master File with the table on which the 
synonym is based.

This feature is available in the Projects on localhost folder and in the Data Servers area 
under the WebFOCUS Environments folder.

1. Right-click a synonym (Master File).

• In the Projects on localhost folder, Master Files are listed in a Master Files folder 
under a project’s name.

• In the WebFOCUS Environments folder, Master Files are listed in the Data Servers 
area under an application’s name. 
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2. Choose one of the following:

• Replace to recreate the Master File.

or

• Create new… to provide a name for the new synonym.

When you choose this option, a new synonym is created based on the name you 
provide, but the original Master File or Access File is not modified.

Synonym names for MVS can have a maximum number of 8 characters, but spaces 
and special characters are not supported. All other synonym names can have a 
maximum of 64 characters, but they also  cannot include spaces or special 
characters. 

Deleting Synonyms

1. In the Explorer Window, right-click the synonym you want to delete.

You will be asked to confirm your deletion.

2. Click Yes to delete or No to cancel.

Procedure How to View or Edit Synonym Code

This feature is available in the Projects on localhost folder and in the Data Servers area 
under the WebFOCUS Environments folder. 

1. Right-click a synonym (Master File).

• In the Projects on localhost folder, Master Files are listed in a Master Files folder 
under a project’s name.

• In the WebFOCUS Environments folder, Master Files are listed in the Data Servers 
area under an application’ name. 

2. Choose one of the following:

• Edit as Text to display code in the text editor.

or

• Open to display in the graphical Master File Editor.

Note: By default, you can view Access (.ACX) Files in the Master Files folder in the Projects 
on localhost area.  In the WebFOCUS Environments folder, you can view Access Files under 
an application’s name. 

To view Access File code, right-click the Access (.ACX) File and then choose Open or Edit 
Access File as Text.

Master Files and Access Files are removed from the server when you delete a synonym. 
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Procedure How to View the Properties of a Synonym

1. Right-click a synonym in the Explorer window and select Properties.

The Properties dialog box displays general file information, such as location, size, and 
other attributes.

2. Check one of the following:

Read-only 

Secures the file because you can not edit or delete it.

or

Encrypted 

Encrypts the contents of the file if the file has DBA security.
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CHAPTER 4

Defining Dimensions for OLAP Analysis

Topics:

• Overview

• Using Dimension Builder

The Dimension Builder enables you to create logical views 
based on enterprise data (relational or legacy data sources) 
for multi-dimensional analysis without manually editing 
metadata. Dimension Builder works with FOCUS data 
sources and relational tables.   

Note: You can use Dimension Builder as an alternative to 
the OLAP tab in the Master File Editor.
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Overview
Dimension Builder enables you to generate new Master Files with dimensions (using 
WITHIN statements) or add dimensions to existing Master Files that need to be used for 
multi-dimensional analysis. Once a Master File is created, it contains the new file structure 
and the Access File, which describes:      

• The relationships of the joined tables using fact and dimension tables. 

• The actual data source location. 

Note: An Access File is created only for relational tables (for example, Oracle, DB2, or 
Sybase). An Access File is not created for FOCUS data sources.

The Dimension Builder allows you to create logical views of data by joining physical tables 
and creating virtual views of that data. The following restrictions apply:

• Joins are permitted only when using relational tables of the same type.

• When using FOCUS data sources, joins are not allowed. You are limited to using a single 
table and working with the multiple segments within the table as if they were different 
tables.

When using relational tables, a star schema (a Fact table linked to Dimension tables) is used. 
For example:
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In the example above, G_SF1997 is the Fact table and the surrounding four tables, each 
linked to the Fact table, are dimension tables, which contain the attributes of the fact 
records.

Single files are used when working with FOCUS data sources.

When using FOCUS data sources, the Dimension Builder splits the various segments of the 
data source and creates a star schema view by virtually joining the segments. For example:

Note: These virtual joins cannot be modified.

Using Dimension Builder

You launch Dimension Builder from the File menu or All Folders window.

Dimension Builder enables you to: 

• Choose Fact and Dimension Tables.

• Specify Dimensions for Reporting.

• Manage Dimension Hierarchies.

• Edit Master Files.
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Procedure How to Launch the Dimensions Tool From the Procedure Window

To launch Dimension Builder from the Procedure window, perform the following steps: 

1. Right-click a component connector and select Dimensions.

2. In the Open dialog box, select a Master File for which you want to create dimensions 
and click Open. The Dimension Tool opens with the Master File you selected.

Procedure How to Launch the Dimensions Tool From the Report Painter

To launch the Dimension Builder from the Report Painter, perform the following steps:

1. Right-click a component connector and select Dimensions.

2. From the Report menu, select OLAP Dimensions.

Select a Master File for which you want to create dimensions. Click OK. The Dimension 
Tool opens with the Master File you selected.
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Specifying Dimensions for Reporting
You can create and name a dimension by dragging a field from the Fact or dimension tables 
under the Dimension entry in the right pane of the Dimension Builder window, or by 
entering a name for the root dimension by right-clicking on Dimensions in the right pane. 

Once you have created your dimension hierarchy for a Master File, close the Dimension Tool 
to return to the Report Painter. You can now use this hierarchy with the OLAP Control Panel. 
For more information about the OLAP creation tool, see the following chapters in Creating 
Reports With Graphical Tools: 

• Chapter 11, Business Intelligence Using OLAP Analysis

• Chapter 12, Manipulating Data in an OLAP-Enabled Report 

Managing Dimension Hierarchies

Procedure How to Create a Dimension

1. Select a field from the Field list. 

2. Drag and drop the selected field to the appropriate level in the right pane of the 
Dimension Builder window. 

Procedure How to Delete a Dimension

To delete a dimension, right-click a dimension and select Delete. 

Editing Master Files With Dimension Builder
You can edit a Master File with Dimension Builder from the File menu or All Folders window. 

Procedure How to Edit a Master File With Dimension Builder

To edit a Master File with the Dimension Builder, perform the following steps: 

1. Select the Master File you want to edit.

2. Right-click and select Edit With Dimension Builder. 

You can create a dimension by dragging and dropping a field from the Field list into the 
Dimension panel. Once dimensions are created, you can drag and drop these dimensions 
within the hierarchy to reorganize the structure. 
Describing Data with Graphical Tools 4-5



Using Dimension Builder
The Dimension Builder displays with the Master File you selected:
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CHAPTER 5

Adding Data and Rebuilding FOCUS Data Sources 

Topics:

• Creating a FOCUS Data Source

• Rebuilding a Data Source

If you choose to create a Master File schema before the 
corresponding FOCUS data source has been created, you 
will need to create and populate the FOCUS data source 
before you can use it in reports or other requests. For 
details about creating a Master File, see Chapter 2, Creating 
Master Files. 

Furthermore, if you modify a Master File in the course of 
your work, you can rebuild the corresponding data source 
using a graphical Rebuild utility.
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Creating a FOCUS Data Source
When you save a Master File, you must also create a corresponding blank data source that 
will hold the data for the fields defined in the Master File. This data source is saved in the 
application’s directory.   

After creating the blank data source, you can load data into it with a MODIFY request, or a 
Maintain request. Once you have populated the data source you can use it in conjunction 
with the Master File in a report request.

Procedure How to Create a Data Source

1. Open the Master File Editor and display the Master File shell you created. 

Tip: Since this a required step, you may wish to complete this procedure immediately 
after creating the Master File, before you close the Master File Editor.

2. Close the Master File Editor. Click Yes when you are prompted to create a blank FOCUS 
(.foc) database file.

FOCUS creates a blank data source (.FOC) in the background. 

The .foc file is stored in the application’s directory.

Rebuilding a Data Source

Procedure How to Use the Rebuild Utility

To open the Rebuild dialog box:   

1. Choose Utilities from the Command menu, then choose Rebuild from the cascading 
menu. The Rebuild dialog box opens.

2. Select a Rebuild option. See Rebuild Dialog Box on page 5-3 and individual procedures 
for each of the Rebuild options.

If you make a change to a Master File in the Master File Editor and wish to rebuild the 
FOCUS data source immediately, choose Rebuild database from the File menu. This is an 
alternative to using the Rebuild dialog box. 

The Rebuild tool provides a number of useful project management utilities. Rebuild 
enables you to restructure data sources, to reorganize data sources when a Master File is 
updated, to rebuild indexes, and to check the integrity of data sources.   

Note: You can only use this utility with FOCUS data sources.
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Reference Rebuild Dialog Box

Choose Utilities from the Command menu, and Rebuild… from the Utilities cascading menu 
to display the Rebuild dialog box. The Rebuild dialog box has the following fields/options:    

• Rebuild a disorganized file

This option can be used to perform the following functions:

• Re-optimize a FOCUS data source after a large amount of data has been added or 
deleted.

• Select specific segment instances to include in the data source, based on record 
selection criteria you specify.

• Reorganize a file to fit a new Master File

Reorganizes data in an existing FOCUS data source after you make changes to its 
Master File. Reorganizing a data source is performed in phases: 

• Select Dump the data during the first phase of the reorganization process.

• Select Load the data during the second phase of the reorganization process.

See How to Reorganize a Data Source to Fit a New Master File on page 5-4. 

• Index a field

Builds or rebuilds the index for the specified field. Use this option to index an additional 
field that was not originally specified as an index field, or to change the index for a field. 
See Rebuilding the Index on page 5-5. 

• Check the integrity of a file

Checks the structural integrity of a data source. If FOCUS encounters an error during 
the check, it displays a message. See Checking the Integrity of a Data Source on page 5-5. 

• Filename

Contains the name of the data source to rebuild. Enter a data source name in the box, 
or click the Browse… button to open a dialog box and select the data source.

• Selection Criteria

Specifies selection criteria for rebuilding a disorganized data source and reorganizing a 
data source to fit a new Master File. Only data that meets the selection criteria are 
included in the rebuilt data source.
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Rebuilding a Disorganized File
This option in the Rebuild dialog box enables you to: 

• Restructure and optimize a FOCUS data source after data has been added or deleted.

• Select specific segment instances for inclusion in the data source based on selection 
criteria you supply. For example, if you specify the following selection criterion

INVOICE_DATE GT 990101

FOCUS will omit invoices earlier than 99/01/01 from the rebuilt data source.

Reorganizing a Data Source to Fit a New Master File
Select this option from the Rebuild dialog box to reorganize data in an existing FOCUS data 
source after making changes to its associated Master File. A change might be the removal 
of a segment or field or the addition of a field at the end of a segment. For more 
information on the changes that you can and cannot make to Master Files, see Describing 
Data With WebFOCUS Language. 

As when you rebuild a disorganized data source, you can specify selection criteria and 
reorganize only the data that meets those conditions. 

Reorganizing a data source is performed in steps, which you must complete in the correct 
order. For the procedure to work, you must dump the existing data before you make any 
changes.

Procedure How to Reorganize a Data Source to Fit a New Master File

1. Place (dump) the data in a temporary workspace. 

a. Select Reorganize a file to fit new Master File under Rebuild Options.

b. Enter the data source name in the File Name box, or click Browse… and select a 
data source from the list.

c. Enter any selection criteria in the Selection Criteria box.

d. Select Dump the data under Reorg Phase.

e. Click OK. 

2. Make the changes to the Master File using the Master File Editor. 

3. Create a new empty data source. 

4. Load the data.

a. Repeat a-c in Step 1.

b. Select Load the data under Reorg Phase.

c. Click OK.
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Rebuilding the Index
When you first create a Master File in the Master File Editor, you specify the fields that you 
want indexed. Sometimes, after data is entered, you may need to index an additional field 
that was not originally specified as an index field. 

The first step is to alter the Master File to indicate that the field should be indexed. Altering 
the Master File does not actually create the index. To do this you must use the Rebuild 
utility after you index a field.

Procedure How to Index a Field After Data Is Entered

From the Master File Editor, select the field to be indexed, and then click the Index box on 
the General tab. 

or

Open and edit the Master File as text in the Text Editor. For instructions on indexing a field 
as text, see Describing Data With WebFOCUS Language. 

After you index a field you must rebuild the index. See How to Rebuild the Index on page 5-5.

Procedure How to Rebuild the Index

1. Select Index a field in the Rebuild dialog box.   

2. Enter a data source name in the File Name box or click Browse… and select a data 
source from the list.

3. Enter the name of the field you want to index in the Field to Index box. 

To index all the fields designated as index fields in that data source, enter an asterisk (*) 
in the Field to Index box. 

4. Click OK.

The Rebuild utility rebuilds the data source, creating an index for all specified fields. 

For more information on indexing fields, see Describing Data With WebFOCUS Language. 

Checking the Integrity of a Data Source
It is rare for the structural integrity of a FOCUS data source to be damaged. Structural 
damage will occasionally occur, however, during a disk drive failure or if an incorrect Master 
File is used. In this situation, you can check the integrity of the Master File. Checking the 
integrity of a Master File performs the following essential tasks: 

• It checks all pointers in the data source.

• Should it encounter an error, it displays a message and attempts to branch around the 
offending segment or instance. In this way, it recovers as much of the data source as 
possible.
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Although checking the integrity reports on a good deal of data that would otherwise be 
lost, it is important to remember that frequently backing up your FOCUS data sources is the 
best method of preventing data loss.

Checking the Master File integrity will occasionally fail to uncover structural damage. If you 
have reason to believe that there is damage to your data source, though results from 
checking the integrity indicates otherwise, there is a second method of checking file 
integrity. This method uses the ? FILE and TABLEF commands. For more information, see 
Describing Data With WebFOCUS Language.

Procedure How to Check the Structural Integrity of a FOCUS Data Source 

Select Check the integrity of a file in the Rebuild dialog box.   

If the Rebuild utility encounters an error during the check, it logs a message for you. You 
should then attempt to recover as much of the data source as possible or restore from 
backup.
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CHAPTER 6

Creating Master and Access Files for Fusion Data Sources 

Topics: 

• Filetool Layout (Fusion Data 
Sources)

• Working With Master Files

• Adding Classes

• Adding Sections

• Adding Fields to a Class or Section

• Adding Virtual Fields to a Class or 
Section

• Adding Group Fields to a Class or 
Section

• Creating a New Cross-Reference 
(Fusion)

• Working With Fusion Access Files

• Setting Up Data Source Security 
(Fusion)

Fusion is a high performance multi-dimensional (MD) 
database whose unique MD index architecture extends the 
scope of high-speed multi-dimensional query 
performance. A Fusion data source offers benefits of high 
three-tier reporting and full integration with EDA and 
FOCUS architecture, and the ability to do multi-
dimensional analysis on both detail and aggregate data. 
The Filetool enables you to create the Master and Access 
Files (metadata) you need to maintain local Fusion data 
sources, and report from Fusion data sources.   

Before you attempt to use the Filetool to create and update 
Master and Access Files for Fusion data sources, see the 
Fusion User’s Manual, which describes Fusion syntax in 
detail.
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Filetool Layout (Fusion Data Sources)

The Filetool window consists of the following items:

• Master File Frame. Provides a hierarchical view of a Master File and its contents. The 
tree hierarchy enables you to perform many standard Windows functions, such as 
expanding or collapsing levels, dragging and dropping classes, sections, and fields, and 
right-clicking for easy access to commonly performed tasks. 

• Access File Frame. Provides a hierarchical view of the associated Access File, including 
its multi-dimensional indexes, horizontal and vertical partitions, and external class and 
index locations. 

When you select the Fusion file type, the Filetool adjusts to support the features and 
terminology you will need to build Fusion Master and Access Files. With Fusion selected, the 
Filetool looks as follows: 
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• Properties Frame. Contains tab dialog windows that provide various options 
depending on the item that is selected in the Master File or Access File frame. For 
example, when a Master File is selected in the Master File frame, the General and DBA tab 
dialog windows appear in the Properties frame. The General tab dialog window enables 
you to select Master File types and default century options and to associate the Master 
File with an Access File. The DBA tab dialog window enables you to set security options. 

• Master File Toolbar. Enables you to perform many common Master File administration 
tasks, such as creating a new class (part-of class, subclass, or section) or field (including 
defined and group fields). It also enables you to create multi-dimensional indexes, 
horizontal partitions, external class locations, and external index locations. 

Reference The Master File Toolbar

The following table describes the tool buttons on the Master File toolbar: 

Button Operation

Defines a new part-of class in a Master File.

Defines a new subclass in a Master File.

Defines a new section in a Master File.

Defines a new field in a Master File.

Defines a new defined field in a Master File.

Defines a new group field in a Master File.

Defines a new multi-dimensional index in a Fusion Master File or Access File.

Defines a new horizontal partition in an Access File.

Defines a new external class location in a Fusion Master File or Access File.

Defines a new external index location in a Fusion Master File or Access File.

Graphically displays the layout of the selected Master File.
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Working With Master Files

Creating a Master File Shell
To create and edit a new Master File, you must first create a new Master File shell. When you 
create a new Master File shell, the Filetool creates a default class and field and assigns a 
name to each. You can change the default names for the Master File, class, and field at any 
time. To change a default name, double-click the default name and type a new name.      

Procedure How to Create a Master File Shell (FUSION)

1. From an open project, right-click the Master Files folder and select New or choose New 
from the File menu. The New Master File dialog box opens.     

2. Choose FUSION from the Suffix drop-down box. Type a name for the Master File in the 
text entry field.

3. Click OK.

The shell file opens in the Filetool.

Saving a Master File
You should save your Master File periodically to safeguard your work. You can save a Master 
File with the Save option after it is created. This option saves a Master File under the name 
that you specify in the Save As dialog box. It also saves an Access File, if one was created, 
under the name that you specify in the Browse dialog box presented for the Access File. 

Note: If a Master File changes and is not saved, an asterisk appears after the top of the 
Master File window next to the name and directory path for the unsaved Master File. If you 
save a Master File after you make changes to it, the asterisk does not appear.

Procedure How to Save a Master File

In the Filetool window, do one of the following: 

• On the File menu, select Save.

• Click the Save button on the Filetool toolbar.

A Master File defines the structure and elements of a data source. Fusion stores the Master 
File in a separate file from the data. Whenever Fusion encounters a report requesting data 
from a data source, it first reads the data source’s associated Master File in order to interpret 
the data. 
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Creating and Adding Data to a Data Source
When you save the Master File, you must create a blank data source. The data source 
contains the data for fields created in the Master File. Fusion creates the data source in the 
background and saves it in the directory specified in the Access File, or in the current 
directory if no Access File exists. 

After creating the blank data source, you can load data into it with a MODIFY request, or a 
MAINTAIN request. Once you have populated the data source, you will be ready to use it in 
conjunction with the Master File in a report request.

Procedure How to Create a Data Source

Select Create Database from the File menu. The Console window opens showing that the 
data source was created. 

Note: The Master File must be open in the Master File window to access the Create 
Database option.

Opening a Master File to View and Edit
You can quickly open an existing Master File to view or edit it. You can view a Master File as 
a file folder or branch hierarchical (top down) structure. The file folder hierarchical structure 
displays in the left pane when you open a Master File. It shows the directory path and the 
root class, followed by either fields or other classes with fields. 

The branch structure shows the directory path, root class, and any other classes in that 
Master File. The branch structure does not show fields in that Master File; however, it 
provides a clearer view of the relationships between classes in the Master File.

To view and edit a Master File, it is recommended that you use the Master File window. 
However, you can also edit a Master File’s characteristics in the Text Editor window. 

If you opened the Master File in the Filetool to make changes, depending on the type of 
changes you made, you will need to perform a rebuild of the data source if a data source 
already exists.

Procedure How to Open a Fusion Master File

From an open project, right-click a Fusion Master File in the Master Files folder and select 
Open from the shortcut menu. The Fusion Master File opens in the Filetool. 

Procedure How to Edit a Master File

Open a Master File. The Master File opens in the Filetool and you can begin to make your 
changes. 
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Procedure How to View the Layout of a Master File

Click Show Layout Window on the Master File toolbar. The Filetool shows the Master File in a 
branch structure. 

Procedure How to Show Master File Information as Text

In an active Master File window, right-click the name of the Master File (located at the top of 
the Master File frame) and select Show Master Text. A window appears that displays the 
Master File as text. Click OK to close the window. 

Closing a Master File
When you close a Master File, if you have not previously saved changes, Fusion asks if you 
want to save the file before you close it. If you close a Master File without saving, you lose all 
changes you did not save previously. 

Procedure How to Close a Master File

Do one of the following: 

• On the File menu, select Close.

• Click the Close button at the top right corner of the Filetool window.

You are prompted to save your changes before exiting. If no changes were made to the 
Master File, it closes without prompting you to save it.

Adding Classes

Fusion recognizes three types of classes:

• Root class. The first class in a Fusion data source. It is the only class in a file that is 
referred to by a special name. All entries in descendant classes start from an entry in the 
root class.

You can find the root class directly below the Master File path. Fusion identifies this 
class with a lock symbol. 

• Part-of class. A class that is a descendant of a higher (parent) class; the relationship 
between its parent class and it is one-to-many.

• Subclass-of. A class that has a one-to-one relationship with its parent class and cannot 
have descendent classes. A unique class is a logical extension of its parent class. When 
data values in a unique class are retrieved, Fusion treats them as if they were part of the 
parent class.

A class is a group of fields that are related to one another. Each class has a unique name and 
each can have its own key field.     
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When you add a new class to a Master File, you first specify a name for the class. Like the 
Master File name, the class name can have up to eight characters. All characters and digits 
are permitted except for embedded blanks and special characters.

Except for the root class, you can change the type of class (if necessary). There are only two 
types of classes you can add to a Master File: the part-of class or the subclass-of class. When 
a class is added, the class type displays in the General tab.

Sorting by Key Fields
If you specify the class as a part-of class, you must set sorting criteria. Sorting criteria are 
based on the key fields identified in the class.   

A key field is a field that uniquely identifies each class instance (collection of data values in 
the fields). For example, no two employees can have the same employee ID number, so you 
can use that field as a key field. A class instance can have more than one field that makes up 
the key; therefore, Fusion may use two or more field values to distinguish records. Key fields 
appear before all other fields in a class and are identified by a key symbol.

Fusion sorts records in a data source by key fields. If you specify more than one key field, 
Fusion sorts the records by the first key field, then the second, and so on.

Once you have specified one or more key fields, you can specify the order in which you 
want Fusion to sort the records. You can have Fusion sort records in ascending or 
descending order. You can also select not to impose a sort order.

Encrypting a Class
You can encrypt the data to scramble the field values of a class. This protects the class from 
examination by an unauthorized user. However, because there is a loss of processing 
efficiency when data is encrypted, encryption is used only in specific cases.   

To encrypt a file at the class level, you must assign a DBA password before setting the 
Encrypt option on (see Adding a DBA and User Password on page 6-26). When the DBA 
password has been assigned, to ensure encryption of the class, you must turn the Encrypt 
option on before adding any records. If you add a record to a class before setting the 
Encrypt option on, that value will not be encrypted.

Once a class is encrypted, you can remove encryption only if you remove the class and 
recreate it without turning on the Encrypt option.
Describing Data with Graphical Tools 6-7



Adding Classes
Procedure How to Add a Class

1. Select the parent class. In the case of a new Master File, select the root class, then 
perform one of the following actions:   

• Right-click and select New, then choose one of the following from the cascading 
menu: Part-of Class or Subclass (for Fusion Master Files) or Parent (for non-Fusion 
Master Files).

• Click the appropriate Class button on the Filetool toolbar.

• From the Insert menu, select Part-of Class or Subclass (for Fusion Master Files) or 
Parent (for non-Fusion Master Files).

In the left pane, the class icon is added beneath the last field in the Part-of class or root 
class. The General tab opens in the right pane.

2. Type a name for the class in the Class Name box.

3. Click the Encrypt box to encrypt the class, if encryption is desired.

For more information on encryption, see Encrypting a Class on page 6-7.

4. Select a class type: either Part-of class or Subclass-of class.

If you select Subclass-of class, you do not specify sorting criteria.

5. Select the sorting criteria for the Part-of parent class.

a. Specify the number of key fields.

b. Select one of the following:

Sort records in ascending order.

Sort records in descending order.

Do not sort records.

6. Once you have defined the class, you can define the fields that will populate the class. 
See Adding Fields to a Class or Section on page 6-10.

Procedure How to Delete a Class

Right-click the class and then select Delete.   

Note: You cannot delete a root class.

Procedure How to Encrypt a Class

1. Assign a DBA password (see Adding a DBA and User Password on page 6-26 for details).   

2. Select the class in the left pane.

3. Select the Encrypt box next to the Class Name in the General tab.
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Adding Sections

Procedure How to Add a Section

1. Select the parent class. In the case of a new Master File, select the root class and then 
perform one of the following actions:   

• Right-click and select New and then choose Section.

• Click the Section button on the Filetool toolbar.

• From the Insert menu, select Section.

In the left pane, the section icon is added beneath the last field in the Part-of class or 
root class. The General tab opens in the right pane. Notice that the Unique section of 
parent class radio button is selected. You can select another radio button to change a 
section to a class type. Also, since a section cannot contain a hierarchy, the sorting 
options are not available. 

2. Type a name for the section in the Class Name box.

3. Click the Encrypt box to encrypt the section, if encryption is desired.

For more information on encryption, see Encrypting a Class on page 6-7.

Procedure How to Delete a Section

Right-click the section and then select Delete.   

Procedure How to Encrypt a Section

1. Assign a DBA password. (See Adding a DBA and User Password on page 6-26 for details.)   

2. Select the section in the left pane.

3. Select the Encrypt box next to the Class Name in the General tab.

A section is similar to a class except that it holds infrequently used or accessed data fields, 
which are not loaded into memory unless specifically requested for in a query. You can add 
a section to an external class location to create a vertical partition. A vertical partition stores 
section data in a separate physical file, which saves space in the main data source and can 
be used to organize data across devices. Vertical partitions increase system optimization 
and Fusion’s overall performance. For information on creating vertical partitions, see 
Vertical Partitions on page 6-24. 
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Adding Fields to a Class or Section

• General. You supply the field characteristics: the field name, field alias, field format, 
whether the field is indexed, and whether the field allows missing data.

• Display. You supply supplementary field information, such as title, help message, and 
description.

• Accept. You supply validation criteria (acceptable values) for a field. Validation criteria 
restricts the values a user can enter for the field.

• Maxvalue. You supply the maximum number of values the field may contain, if known.

You must supply at least a field name and a field format. 

See the procedure How to Add a Field to a Class or Section on page 6-12 for restrictions on 
entering required and optional information.

Adding a Field Name
After adding a field to a class or section, you must assign a field name.     

You should provide a unique field name of 1 to 66 characters, and the first character must 
be a letter. The field name appears as a column heading when you include the field in a 
report request against a Fusion data source, unless you have specified a title for the field. 
Avoid using embedded blanks and special characters if you plan to use the field in a 
calculation.

You can specify an alias for each field. An alias is a shorter, alternate name that identifies the 
field. Once assigned, you can use this alias as a synonym for the regular field name in a 
report request against a Fusion data source. The length and format rules are the same as 
those for field names, but aliases are usually brief names used to reduce typing. Fusion does 
not use aliases as column titles.

Selecting a Field Format
The field format describes the type and length of data as it is actually stored in the data 
source. You must specify a field format for every field you add. You assign a format based on 
the values that the field will hold. The field format specifies the following information:     

• The field type, which indicates whether the field value will contain an alphanumeric, 
numeric, or date value.

• The field length, which determines the maximum number of positions an 
alphanumeric or numeric field value can contain.

When you add a field to a class or section, a field icon is placed below the class (or section) 
in the Master File tree and file properties are displayed in the right pane. You supply the 
information that defines the field in these file properties.     
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• Edit options that affect how a numeric or date field value will appear in reports.

• Date format, internal format, and century options for date fields.

Identifying Missing Data
If a class instance exists but no data has been entered into one of its fields, that field has no 
value. Fusion indicates this absence of data as a null value or missing data. You use the 
Allow Missing Data option to instruct Fusion to enter a missing value for a field when read 
from a data source. If Fusion reads a field with a missing value when the option has been 
selected, it ignores that value when it performs an aggregating calculation, such as 
averaging. If the report specifies displaying a field, Fusion displays a special character that 
indicates a missing value.     

Missing data is significant in reports, especially those that perform aggregating functions. 
You can allow missing data to be entered into or read from a field by activating the Allow 
Missing Data option in the General tab. When you activate this option, Fusion can 
distinguish a null value from an intentionally entered blank or zero. 

Adding Supplementary Information to a Field
The title, help message, and description parameters are optional parameters you can 
supply for a field. These parameters make it easier for you to describe the field to users.     

• Title. A field’s title that appears on a report in place of the field name. Fusion uses the 
field name as the column title by default. The title can contain up to 64 characters.

• Help message. A one line text message that provides additional information about a 
field. This message can be up to 78 characters. 

• Description. Provides information that will help you identify the data field. The 
description can be up to 44 characters long. 

Controlling Acceptable Values for a Field
You can control the acceptable values by setting validation criteria for a field. If you set 
validation criteria for a field, your project will allow only certain incoming values for the 
field. If a user enters an unacceptable value for the field, a list of acceptable values will be 
displayed from which the user can make a selection.     

The validation criteria that you can specify are:

• None. You do not want to supply validation criteria for the field. A user can enter any 
value (within the limitations of the field’s format) for the field. This is the default setting.

• List. Supply a list of valid values. A user can enter only a value from this list.
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• Range. Supply a range of valid values. For example, the range of valid values for an 
integer field might be from 100 to 200. A user can enter only a value that is within the 
range.

• Find. Supply file and field names that instruct Fusion where to search for a file and for a 
list of acceptable values within that file. You supply the field name of the data field that 
the validation criteria is being assigned, the file name of the target Fusion or FOCUS file 
where the field might be found, and the field name of the target data field that contains 
the validation criteria.

Note: Find is not an option for non-Fusion and non-FOCUS data sources.

Indexing a Field
You can have Fusion index the values of a field by activating the Index option when you add 
a field and before you add the data. An index is an internally stored and maintained table of 
data values and locations that enhance the performance of data retrieval. A Master File can 
have several associated indexes, but the combined total of indexes and classes cannot 
exceed 192.     

You can turn on the index after adding data to a field. In this case, you must use the Rebuild 
Index option to create the index.

Procedure How to Add a Field to a Class or Section

1. In the hierarchical structure, select the class or section in which you want to add a field 
and then perform one of the following actions:     

• Right-click and select New, then choose Field from the cascading menu.

• Click the New Field button on the Filetool toolbar.

• Select Field from the Insert menu.

The Filetool displays the General, Display, and Accept tabs in the right pane.

2. In the General tab:

a. Type a name for the field in the Field Name input box (required).

b. Click the Index box if you want the field to be indexed.

c. Click Allow Missing Data if you want to instruct Fusion to enter a missing value for a 
field if no value exists.

d. Type an alias for the field in the Field Alias input box (optional).

e. Select a format type and then specify the length, the decimal place (if applicable), 
and any edit options for the field. The format type, length, and/or decimal place are 
required parameters; edit options are not. For more information about field 
formats, see Creating Reports With Graphical Tools.
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3. Click the Display tab to include a column title, help message, or a description for the 
field. To include any of these characteristics, type the text in the appropriate input box.

4. Click the Accept tab to specify validation criteria. The validation criteria limit the values 
that a user can enter for the field. The default value is None, which indicates no 
validation criteria.

Select List of Values to specify a list of acceptable field values.

1. Type a value in the input box and click Enter.

Fusion Administrator adds the value to the list box.

2. Continue to type values and add them to the list box.

Select Range of values to specify a range of acceptable field values.

1. Type the minimum range value in the From input box.

2. Type the maximum range value in the To input box.

To specify a file that contains the values, select Find in file.

1. In the Field Name list box, select the field whose valid values you are looking for.

2. In the Filename input box, type the name of the target file that contains the valid 
values. You can also click the Browse button to find the target file.

3. In the target Field Name input box, type the name of the field that contains the 
acceptable values within the file.

4. Once you have supplied information for the required parameters and any optional 
parameters, the field definition is complete. You can now add other fields to the current 
class, add fields to another class, or create a new class.

Procedure How to Delete a Field From a Class or Section

Right-click the field and then select Delete.     

Adding Virtual Fields to a Class or Section

The procedure for adding a virtual field to a Master File is similar to the procedure used to 
add any field to a Master File. You must specify a field name, an expression, and a field 
format for the virtual field. 

A virtual field is a field whose value is not stored in the data source but can be calculated 
from the data that is there. You create a virtual field in your Master File for reporting 
purposes. The field is available whenever a user accesses the corresponding data source. 
This feature is convenient when you want to use a virtual field in many different report 
requests that use the same data source; it saves you the effort of defining the field in each 
request. 
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The difference between adding a virtual field and a regular field is that you must define the 
field by using at least one other real field that belongs to the same class or section. You use 
this real field to build an expression that defines the values a virtual field will hold. An 
expression enables you to combine fields, constants, predefined functions, and operators 
into one statement that produces a single value. For more information about defining 
fields, see Creating Reports With Graphical Tools.

Defining Expressions for Virtual Fields
You can type the syntax for the expression directly into an input box, or you can access the 
Define Expression Assistant, which will help you build the field’s expression.   

The Define Expression dialog box displays a list of available fields, functions, and logical and 
mathematical operators you can use to build the syntax for the expression.

As with any other field, you can also specify the optional parameters: title, help message, 
description, and validation criteria. See Adding Fields to a Class or Section on page 6-10 for 
information.

Procedure How to Add a Virtual Field to a Class or Section

1. In the hierarchical structure, select the class or section in which you want to add a 
temporary field, then perform one of the following actions: 

• Right-click and select New, then choose Defined field from the cascading menu.

• Click the New Defined Field button on the Filetool toolbar.

• Select Defined Field from the Insert menu.

The Filetool displays the General, Display, and Accept tabs in the right pane.
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2. In the General tab:

Type a name for the field in the Field Name input box (required).

a. Click Allow Missing Data if you want to instruct Fusion to enter a missing value for a 
field.

b. Type the syntax for the expression in the Expression input box (required). To create 
an expression using the Define Expression Assistant, click the Assist button to open 
the dialog box.

When you have completed the expression, click OK to exit the Define Expression 
dialog box and save it.

The expression will display in the Expression input box.

c. Select a format type and then specify the length, the decimal places (if applicable), 
and any edit options for the field. The format type, length, and/or decimal places 
are required parameters; edit options are not. For more information about field 
formats, see Creating Reports With Graphical Tools.

3. Click the Display tab to include a column title, help message, or a description for the 
field. To include any of these characteristics, type the text in the appropriate input box.

Once you have supplied information for the required parameters and any optional 
parameters, the field definition is complete. You can now add other fields to the current 
class, add a field to another class, or create a new class.

Adding Group Fields to a Class or Section

Procedure How to Add a Group Field to a Class or Section

1. In the hierarchical structure, select the class or section in which you want to add a 
group field and then perform one of the following actions:     

• Right-click and select New, then choose Group Field from the cascading menu.

• Click the New Group Field button on the Filetool toolbar.

• Select Group Field from the Insert menu.

The Filetool displays the General and Display tabs in the right pane.

2. In the General tab, type a name for the group field in the Group Name input box 
(required).

You can assign a unique name to a group of multiple fields to create a group field. A group 
field should be created if multiple fields exist that can be logically grouped together but 
that do not warrant a separate class or section. A group field provides an efficient means for 
grouping similar fields that will be accessed as a single unit.     
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Notice that the default format is A40 and the field names in the group appear in the 
Fields Within Group box at the bottom of the tab window.

3. Click the Display tab to include a column title, help message, or a description for the 
field. To include any of these characteristics, type the text in the appropriate input box.

4. Click a field in the group field hierarchy and supply the required information in the 
General, Display, Accept, and Maxvalue tab windows. For information about these tab 
windows, see the procedure How to Add a Field to a Class or Section on page 6-12.

Once you have supplied information for the required parameters and any optional 
parameters for each field, the group field definition is complete. You can now add other 
fields (or group fields) to the current class or section, add fields to another class or section, 
or create a new class or section.

Procedure How to Add a New Field to a Group Field (Fusion)

Click the group field to which you want to add a new field and do one of the following:     

• Right-click and select New, then choose Field from the cascading menu.

• Click the New Field button on the Filetool toolbar.

• Select Field from the Insert menu.

The Filetool displays the General, Display, and Accept tabs in the right pane. Supply the 
required information in each of the tab windows. For information about these tab windows, 
see the procedure How to Add a Field to a Class or Section on page 6-12.

Procedure How to Add an Existing Field to a Group Field (Fusion)

1. Click the field you want to add to the group field.     

2. While holding the left mouse button down, drag the field, and drop it on the group 
field name. 

The field is added to the group field.

Procedure How to Delete a Group Field From a Class or Section

Right-click the group field, then select Delete.     

Procedure How to Delete a Field From a Group Field (Fusion)

Right-click the field, then select Delete.     
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Creating a New Cross-Reference (Fusion)

There are two types of cross-references that you can choose to create: a one-to-one cross-
reference or a one-to-many cross-reference. A one-to-one cross-reference creates a unique 
relationship between the source and target classes, meaning any instance of the source 
class can have at most one matching instance in the target class. If multiple matching 
instances exist in the target file, Fusion retrieves only one. With a one-to-many cross-
reference, a non-unique relationship is created between the source class and target class 
resulting in the possibility of multiple matching instances in the target class. 

The cross-reference wizard allows you to indicate whether to activate the Remembered 
option or Limit to current class option for the cross-reference. The Remembered option 
stores the locations of all matching target instances in the source data source. The Limit to 
current class option limits the cross-reference to the named target class, therefore not 
involving the entire cross-referenced structure in the logical data source. 

Procedure Using the New Cross-Reference Wizard (Fusion)

1. Click on the host class or field in the Master File for which you wish to create a cross-
reference.   

2. Click on the New Cross-Reference button on the Master File toolbar to activate the 
wizard.

3. The wizard will ask you to enter the information discussed above through a series of 
windows. Click Next or Back to move forward or backward, respectively, through these 
windows.

Note: If you are creating a new Master File, the New Cross-Reference Wizard button on the 
Master File toolbar will not be active until you save the Master File on a server.

To report from two separate data sources with corresponding data types and values in one 
or more fields use the New Cross-Reference wizard to create a cross-reference. A cross-
reference identifies matching instances from the two files based on their common fields. 
Once the cross-reference has been created, Fusion will retrieve matching data from the 
second (target) file when it retrieves a class instance from the first (source) file. In the 
Filetool, a cross-reference wizard will guide you through the process of creating a cross-
reference. You must select the host field, target field, and the type of cross-reference you 
want.   
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Working With Fusion Access Files

The Filetool enables you to create Access Files for Fusion data sources. If you create a Fusion 
Master File, the Access File is located in the same directory as the Master File and its 
structure displays in the Access File frame.

An Access File is required to create a horizontal partition. To create a multi-dimensional 
index, an external class location, or an external index location an Access File is 
recommended but not required. If you create a multi-dimensional index, an external class 
location, or an external index location without an Access File, the default name for the 
index or location is used and its physical files are stored in the same location as the Master 
File.

For more information on Fusion Access Files, see the Fusion User’s Manual.

Procedure How to Create a Fusion Access File

1. In an active Master File window, click the Master File’s name and directory path, located 
at the top of the Master File frame.   

2. In the Properties frame, click the General tab.

3. In the Fusion Access File Options section, click the External Access File radio button.

4. A message appears stating that an external Access File requires a horizontal partition 
and one will be created for you. Click Yes to continue.

The Filetool automatically creates, names, and associates an Access File and horizontal 
partition for the selected Master File. To change the name of the horizontal partition, click 
the horizontal partition’s name and then click it again. A cursor appears, allowing you to 
type either a new name, the fully qualified path and name, if the data source will reside in a 
location other than where the Master and Access Files reside, or data set name for the data 
source.

Procedure How to Remove All Fusion Access File Information

In an active Master File window, right-click the name of the Access File (located at the top of 
the Access File frame) and select Remove All Access Info. The Access File and its contents 
(multi-dimensional indexes, partitions, and external locations) are deleted.   

An Access File provides comprehensive metadata management for all data sources. An 
Access File describes how to locate, concatenate, join, and select the appropriate physical 
data sources for retrieval requests against one or more Fusion data sources.   
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Procedure How to Show Fusion Access File Information as Text

In an active Master File window, right-click the name of the Access File (located at the top of 
the Access File frame) and select Show Access File Text. A window appears that displays the 
Access File as text. Click OK to close the window. 

Changing a Fusion Access File

Procedure How to Change a Fusion Access File

1. In an active Master File window, select Change Access File from the File menu. 

A list of available Access Files on the current server appears.

2. Select the Access File you want to replace the current one with and click Open.

The Access File you selected replaces the current one. 

Multi-Dimensional Indexes

To create a multi-dimensional index that has one partition, an Access File is not required 
and the multi-dimensional index file is saved in the same directory as the Master File. If the 
multi-dimensional index contains more than one partition or if you want to store it in a 
directory other than where the Master File resides, you must first create an Access File. For 
more information about Fusion multi-dimensional indexes, refer to the Fusion User’s 
Manual.

Procedure How to Create a Multi-Dimensional Index

1. In an active Master File window, select the Multi-dimensional Indexes folder and do one 
of the following:    

• Right-click the Multi-dimensional Indexes folder and select New Multi-dimensional 
Index from the menu that appears.

• Click the New Multi-dimensional Index button on the Master File toolbar.

• Select Multi-dimensional Index from the Insert menu.

You can change a Master File’s association with an Access File and replace it with another 
available Access File. When you change an Access File, its association with the Master File is 
removed and replaced by that of another Access File; however, the original Access File is not 
deleted. The physical file still exists on the server and can be used, or associated, with other 
Master Files. 

A multi-dimensional index uses dimensions and all of their hierarchical relationships to 
point to specific facts in a Fusion data source. The multi-dimensional index is one of the 
features that gives Fusion its superb retrieval performance.    
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2. Type the name of the multi-dimensional index in the Index Name entry box, located in 
the General tab dialog window of the Properties frame.

Note: You can accept the default index name by clicking another item in the Access File 
frame.

3. Select the class with which the index is primarily associated from the Class Association 
drop-down selection list. The list contains all available classes in the Master File frame.

Note: The class that is associated with a multi-dimensional index should contain the 
majority of relevant facts as compared to other classes in the data source.

4. You can add or remove partitions by clicking the Partitions tab, selecting a partition, 
and clicking the Add or Remove buttons.

Note: To add data to an existing multi-dimensional index, the index must have at least two 
partitions. Also, a partition name can include a fully qualified path (including the file name) 
to store the multi-dimensional index’s files in a location other than where the Master and 
Access Files reside.

Procedure How to Add a Dimension to a Multi-Dimensional Index

1. In the Master File frame’s tree hierarchy, click the field you want to add to the 
multi-dimensional index.    

2. While holding the left mouse button down, drag the selected field down to the Access 
File frame and do one of the following:

• To add a dimension that is not hierarchical within the multi-dimensional index, 
drop the field on the multi-dimensional index’s name.

• To add a dimension that is a part of another dimension (hierarchical), drop the field 
on the name of the dimension that is above it in the hierarchy.

Procedure How to Delete a Multi-Dimensional Index or Dimension

In an active Master File window, select the multi-dimensional index or dimension you want 
to delete and do one of the following:    

• Right-click the multi-dimensional index (or dimension) and select Delete from the 
menu that appears.

• Click the Delete button on the Filetool toolbar.

• Select Clear from the Edit menu.

Note: Since a multi-dimensional index resides outside the data source, you do not need to 
rebuild the data source if you delete the multi-dimensional index’s references in the Master 
and Access Files.
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External Class Locations

Procedure How to Create an External Class Location

1. In an active Master File window, select the External Class Locations folder (located in the 
Access File frame) and do one of the following: 

• Right-click the External Class Locations folder and select New External Class Location 
from the menu that appears.

• Click the New External Class Location button from the Master File toolbar.

• Select External Class Location from the insert menu.

2. Type the name of the external class location in the Location Name entry box, located in 
the General tab dialog window of the Properties frame.

Note: You can accept the default name by clicking another item in the Access File frame or 
you can specify a fully qualified path and file name to store the data in a location other than 
where the Master and Access Files reside, or data set name.

Procedure How to Add a Class to an External Class Location

1. In the Master File frame’s tree hierarchy, click the class you want to add to the external 
class location.   

2. While holding the left mouse button down, drag the selected class down to the Access 
File frame and drop it on the desired external class location name.

Procedure How to Delete an External Class Location

In an active Master File window, select the external class location you want to delete and do 
one of the following: 

• Right-click the external class location and select Delete from the menu that appears.

• Click the Delete button on the Filetool toolbar.

• Select Clear from the Edit menu.

An external class location stores the data for a specific class in a separate physical file. An 
external class location can be used, for example, when disk space is unavailable for the 
entire data source and you want to store data for a data source on separate physical drives. 
Although it is not required, you can associate an external class location with an Access File. 
Describing Data with Graphical Tools 6-21



Working With Fusion Access Files
Procedure How to Delete a Class From an External Class Location

In an active Master File window, select the class you want to delete and do one of the 
following:   

• Right-click the class and select Delete from the menu that appears.

• Click the Delete button on the Filetool toolbar.

• Select Clear from the Edit menu.

External Index Locations

Procedure How to Create an External Index Location

1. In an active Master File window, select the External Index Locations folder (located in the 
Access File frame) and do one of the following: 

• Right-click the External Index Locations folder and select New External Index Location 
from the menu that appears.

• Click the New External Index Location button from the Master File toolbar.

• Select External Index Location from the Insert menu.

2. Type the name of the external index location in the Location Name entry box, located 
in the General tab dialog window of the Properties frame.

Note: You can accept the default name by clicking another item in the Access File frame or 
you can specify a fully qualified path and file name to store the data in a location other than 
where the Master and Access Files reside, or data set.

Procedure How to Add an Indexed Field to an External Index Location

1. In the Master File frame’s tree hierarchy, click the indexed field you want to add to the 
external index location. 

2. While holding the left mouse button down, drag the selected indexed field down to the 
Access File frame and drop it on the desired external index location name.

An external index location stores the data for a specific index in a separate physical file. An 
external index location can be used, for example, when disk space is unavailable for the 
entire data source and you want to store data for a data source on separate physical drives. 
Although it is not required, you can associate an external index location with an Access File. 
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Procedure How to Delete an External Index Location or Indexed Field

In an active Master File window, select the external index location or indexed field you want 
to delete and do one of the following:   

• Right-click the external index location (or indexed field) and select Delete from the 
menu that appears.

• Click the Delete button on the Filetool toolbar.

• Select Clear from the Edit menu.

Horizontal Partitions

A horizontal partition separates the data source into separate files. This separation provides 
a simple way to maintain historical data and can be based on user-selected categories, such 
as year or region. Separate partitions remain one logical data source and Fusion, using the 
information provided in the predicates, selectively accesses only those partitions that 
satisfy each query. For more information on horizontal partitions, see the Fusion User’s 
Manual.

Procedure How to Create a Horizontal Partition

1. In an active Master File window, select the Horizontal Partition folder and do one of the 
following: 

• Right-click the Horizontal Partitions folder and select New Horizontal Partition from 
the menu that appears.

• Click the New Horizontal Partition button on the Master File toolbar.

• Select Horizontal Partition from the Insert menu.

2. Type the name of the partition in the File Name entry box, located in the General tab 
dialog window of the Properties frame. You can type a fully qualified path and file name 
so that Fusion puts the data source in a place separate from the Master and Access Files, 
or data set.

Note: You can accept the default partition name by clicking another item in the Access 
File frame.

3. You can partition data based on an expression. To do so, click the check box next to 
Data is partitioned based on expression… and do one of the following:

• Click the Assist button to create an expression with the Assist Wizard.

• Type the expression in the text box below the expression check box.

Unlike a multi-dimensional index and an external class or index location, a horizontal 
partition requires an Access File. In fact, whenever you create an Access File, a default 
horizontal partition is automatically created for you.   
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Procedure How to Delete a Horizontal Partition

In an active Master File window, select the horizontal partition you want to delete and do 
one of the following: 

• Right-click the horizontal partition and select Delete from the menu that appears.

• Click the Delete button on the Filetool toolbar.

• Select Clear on the Edit menu.

Caution: If data exists in a partition that you delete, the data and its references in the 
associated Master and Access Files will be permanently lost. The same is true if this 
partition’s data was built into a multi-dimensional index.

Procedure How to Remove All Horizontal Partitions

In an active Master File window, right-click the Horizontal Partitions folder and select 
Remove All Partitions from the menu that appears. 

Vertical Partitions

Procedure How to Create a Vertical Partition

To create a vertical partition, you must first create an external class location and a section. 
For information on creating an external class location, see External Class Locations on 
page 6-21. For information on creating a section, see Adding Sections on page 6-9. 

1. In the Master File frame’s tree hierarchy, click the section you want to add to the 
external class location.

2. While holding the left mouse button down, drag the selected section down to the 
Access File frame and drop it on the desired external class location name.

Procedure How to Delete a Vertical Partition

In an active Master File window, select the vertical partition you want to delete and do one 
of the following: 

• Right-click the vertical partition and select Delete from the menu that appears.

• Click the Delete button on the Filetool toolbar.

• Select Clear from the Edit menu.

A vertical partition is a section whose data is stored in a separate physical file (an external 
class location). A vertical partition separates infrequently accessed pieces of data source 
records from the rest of the data, which minimizes retrieval overhead and memory usage. It 
can also organize data across devices for system optimization. For more information about 
vertical partitions, refer to the Fusion User’s Manual.   
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Setting Up Data Source Security (Fusion)

For each data source, security can be maintained at two different levels: 

• Database Administrator Level. You specify the database administrator (DBA) 
password for the data source. The DBA has unlimited access to the data source.

• User Level. You specify the DBA and user passwords for the data source. The user 
password represents a user who has access to that data source. Each user’s security can 
be limited even further by specifying a type of file access and/or by restricting access to 
classes, fields, or field values.

Once a user password has been established, you can apply the same restrictions to multiple 
users.

When the DBA or user no longer needs access to the data source, you can delete their 
security.

Before adding any type of security to a data source, the database administrator must be 
aware of certain DBA guidelines, outlined in the following section.

DBA Guidelines
You can ensure that the security restrictions you place on data sources are correct by 
adhering to the following guidelines:     

• Every file with access limits must have a DBA password.

• No class, field, or field value restrictions may be specified at the database administrator 
level. The database administrator should have unlimited access to the data source and 
all cross-referenced data sources.

• Once security restrictions have been applied, the database administrator should 
conduct thorough testing of every restriction before the data source is used. It is 
particularly important to check field values to make sure they do not contain errors. If 
they are in error, user access to the fields’ data will be unnecessarily restricted.

• All groups of cross-references data sources must have the same security restrictions.

• You must have a DBA password to encrypt and decrypt or restrict existing data sources.

• The database administrator can change any type of security restriction.

• Access levels affect which Fusion functions users can issue. The database administrator 
must consider what commands that user will need. If a user does not have access rights 
to use a given function, that user will receive an error message.

Fusion data source security provides control over data source access. Although you set 
security in the Master File, it applies to the data source. To prevent unauthorized viewing 
and editing of a Master File, you must encrypt the Master File. For more information on 
encrypting a Master File, see Encrypting and Decrypting a Master File on page 6-26.     
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Adding a DBA and User Password
The DBA password identifies the database administrator. Only the database administrator 
has complete access to the data source and can set up or change security restrictions for 
individual users. Also, only the database administrator can encrypt (scramble) or decrypt 
(unscramble) a Master File (see Encrypting and Decrypting a Master File on page 6-26).   

The user password identifies the users who have access to the data source. When you 
specify a user password, you must also set at least the type of file access. If the user 
password is not defined in a Master File, the user is denied access to that data source.

The DBA file name and user passwords can each contain up to eight characters. You assign 
the DBA and user passwords on the DBA tab, which appears when you click the Master File 
path of the hierarchical structure in the left pane. Once you have logged a password the 
DBA file and Users fields will become active. At this point either a DBA file name can be 
entered in the DBA file field or User specified from the Users list. When a DBA file name is 
entered the Users field becomes inactive and conversely when a User is specified the DBA 
file field becomes inactive.

When security is specified, the database administrator or user must enter a password to get 
access to the data source.

Encrypting and Decrypting a Master File
You may use the Encrypt and Decrypt options to scramble and unscramble some or all of 
the contents of a Master File from viewers. When you encrypt Master Files, they are secure 
from unauthorized examination.    

Encryption of the Master File scrambles the entire contents of that Master File so it is 
unreadable. When you encrypt a Master File, you can also decrypt it. Decrypting 
unscrambles the contents of the Master File to its readable state.

Before you can encrypt or decrypt any Master File or class, you must first specify the DBA 
password. If you do not specify a DBA password, you will not be able to encrypt or decrypt a 
Master File.

Within a Master File, you can encrypt a class. For details, see Encrypting a Class on page 6-7.

When you assign a user password, Fusion activates the option for specifying the type of file 
access and access restrictions. You must specify at least the type of access the user is 
permitted to have for the data source. The type of file access can be specified in the File 
Access group on the DBA tab. In this group, there are four file access options:        

• Read. Allows the user only to read (to view) the data source.

• Write. Allows the user only to write (to add or to make changes) to the data source.

• Read/Write. Allows the user to read and write to the data source.

• Update. Allows the user to update (to make changes to) existing field values in the 
data source.
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The type of file access determines what a user can do to the entire data source. If you 
specify only the type of file access without restricting access to classes, fields, or field values, 
the user will have unlimited access to the data source.

If you want the user to have less access to the data source, you can restrict access even 
further to classes, fields, and/or field values.

Restricting Access to Classes, Fields, and Field Values
You can restrict access to classes, fields, and field values in a data source by specifying 
access restrictions for a user. When you specify what is to be restricted—class, field, and/or 
field value—you can then specify the type of access that will be restricted. For fields, you 
can also specify whether you want the field to be displayed. For field values, you are 
required to enter a test condition.       

• Classes. You specify the type of access for individual classes or all classes.

• Fields. You specify the type of access for individual fields or all fields. You can also 
specify not to display the data in that field using NoPrint. If you specify NoPrint for a 
field, the data will appear as blanks for alphanumeric format or zeros for numeric 
format whenever the user tries to retrieve it.

• Field Values. You specify the type of access (read or write) and the test condition. The 
user is restricted to using only those values that satisfy the test condition.

Procedure How to Set Up Security for the Database Administrator

1. Click the Master File path on the hierarchical structure.    

The General and DBA tabs open.

2. Click the DBA tab and then type the DBA password in the DBA Password box.

Note: When the password is created and the cursor is in that field, you can right-click 
and use the edit options to undo, select all, cut, copy, paste, or delete the password.

3. Save the Master File with the DBA password.

Procedure How to Set Up Security for the User

1. Set up security for the database administrator.    

2. Tab to the Users box and then type the User password and hit the Enter key to add the 
user.

The File Access, Access Restrictions, and Same Restriction options are activated.

Note: When the password is created and the cursor is in that field, you can right-click 
and use the edit options to undo, select all, cut, copy, paste, or delete the password.

3. Select the type of file access from the File Access group.
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4. Select the type of restriction—class, field, and/or field value—from the Access 
Restrictions group, then select the type of access for each. See Restricting Access to 
Classes, Fields, and Field Values on page 6-27 for details.

5. Save the Master File with the user password and restrictions.

Procedure How to Encrypt a Master File

1. On the DBA tab, type the DBA password in the DBA Password box.    

2. Save the Master File with the DBA password.

3. Open the Console window.

4. Submit the following SET command:

SET PASS=dbapass

5. Submit the following ENCRYPT command

ENCRYPT FILE fname

where:

fname

Is the name of the Master File you want to encrypt.

The Master File is encrypted.

Procedure How to Decrypt a Master File

1. Open the Console window. 

2. Submit the following SET command:

SET PASS=dbapass

3. Submit the following DECRYPT command

DECRYPT FILE fname

where:

fname

Is the name of the Master File you want to decrypt.

The Master File is decrypted.
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Applying Security Restrictions for Multiple Users
You can specify restrictions for one user and then apply the same restrictions to other users. 
This technique is useful when you want to set the same restrictions for a group of users.     

Procedure How to Apply Previously Defined Restrictions to Another User

1. On the DBA tab, tab to the Users group and type the new user password; press the 
Enter key.     

The Same Restrictions group is activated.

2. In the Same Restrictions group, click the User Same as… box to show a check mark.

3. Click the arrow on the drop-down combo box and then select the user with the security 
restrictions that would apply to the new user.

Security restrictions from the user in the User Same as… box are applied to the new 
user. You can apply the security restrictions to other users by repeating steps 1 to 3.

Note: You must have created at least one user security restriction to apply security 
restrictions to multiple users.

Deleting a DBA or User’s Password
You can delete a DBA or user’s security when it is no longer needed. 

Procedure How to Delete a User’s Password

1. Do one of the following: 

• On the DBA tab, type the user password in the Users box.

• Double-click on the user name so that it displays in the Users box.

2. Press the Delete key on the keyboard.

The DBA dialog box opens.

3. Select Yes.

If you delete the user whose security restrictions you have applied to other users, you must 
reset security restrictions for all users attached to the user you deleted.

Procedure How to Delete a DBA Password

Deleting a DBA’s security will delete all users’ security for that Master File. 

1. On the DBA tab, highlight the DBA password in the DBA password box.

2. Press the Delete key on the keyboard.

The Warning dialog box opens.

3. Select OK.
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Reader Comments

In an ongoing effort to produce effective documentation, the Documentation Services staff at 
Information Builders welcomes any opinion you can offer regarding this manual.
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Comments:

Mail: Documentation Services - Customer Support
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Fax: (212) 967-0460

E-mail: books_info@ibi.com

Web form: http://www.informationbuilders.com/bookstore/derf.html
Information Builders,  Two Penn Plaza,  New York,  NY  10121-2898 (212) 736-4433
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